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Preface

Profile

Before You Begin This Course

Before you begin this course, you should have the following qualifications:

• Thorough knowledge of basic MRP II and accounting concepts.

• Working experience with cost accounting activities in various different
manufacturing environments.

Prerequisites

• Oracle Inventory Release 11

• Oracle Purchasing Release 11

• Oracle Bills of Material and Engineering Release 11 (if products are
installed at your site)

• Oracle Work In Process Release 11 (if products are installed at your site)

• Oracle Planning Release 11

• Oracle General Ledger Release 11

• R11i Costing Setup and Implementation

• R11i Cost Information

• R11i Cost Rollup

• R11i Average Costing

• R11i Standard Costing

How This Course Is Organized

R11i Analyzing Inventory and WIP Transactions is an instructor-led course
featuring lecture and hands-on exercises.  Online demonstrations and written
practice sessions reinforce the concepts and skills introduced.
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Related Publications

Oracle Publications

Title Part Number

Oracle Inventory User’s Guide Release 11i A58270-01

Oracle Purchasing User’s Guide Release 11i A82912-01

Oracle Bill of Materials User’s Guide Release 11i A75087-01

Oracle Engineering User’s Guide Release 11i A75090-01

Oracle Work In Process User’s Guide Release 11i A75101-01

Oracle Cost Management User’s Guide Release 11i A75088-01

Oracle General Ledger User’s Guide Release 11i A82850-01

Additional Publications

• System release bulletins

• Installation and user’s guides

• read.me files

• Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Analyzing Inventory and WIP Transactions Table of Contents
vii

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab

(I) = Icon

(H) = Hyperlink

(B) = Button
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Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Analyzing Inventory and WIP Transactions Table of Contents
ix

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.

3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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Analyzing Inventory and WIP
Transactions

Analyzing Inventory and WIP
Transactions

Analyzing Inventory TransactionsAnalyzing Inventory Transactions
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ObjectivesObjectives

After completing this lesson, you should be able to:
• Use inventory distribution inquiries
• Resubmit errored transactions
• Use margin analysis reports
• Use inventory distribution reports
• Perform inventory input/output analysis
• Analyze purchase price variance (PPV) and invoice

price variance (IPV)

After completing this lesson, you should be able to:
• Use inventory distribution inquiries
• Resubmit errored transactions
• Use margin analysis reports
• Use inventory distribution reports
• Perform inventory input/output analysis
• Analyze purchase price variance (PPV) and invoice

price variance (IPV)
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AgendaAgenda

• Overview of Analyzing Inventory Transactions
• Inventory Distribution Inquiry
• Resubmit Errored Transactions for Costing
• Generating Margin Reports
• Analyzing Inventory Transactions

• Overview of Analyzing Inventory Transactions
•• Inventory Distribution InquiryInventory Distribution Inquiry
•• ResubmitResubmit Errored Errored Transactions for Costing Transactions for Costing
•• Generating Margin ReportsGenerating Margin Reports
•• Analyzing Inventory TransactionsAnalyzing Inventory Transactions
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• Use various inquiries and reports to help you
analyze the accounting impact of your material
transactions.

• Use various inquiries and reports to help you
analyze the accounting impact of your material
transactions.

Inquiries and analysisInquiries and analysisMaterial  transactionsMaterial  transactions
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• Overview of Analyzing Inventory Transactions
• Inventory Distribution Inquiry
• Resubmit Errored Transactions for Costing
• Generating Margin Reports
• Analyzing Inventory Transactions

•• Overview of Analyzing Inventory TransactionsOverview of Analyzing Inventory Transactions
• Inventory Distribution Inquiry
•• ResubmitResubmit Errored Errored Transactions for Costing Transactions for Costing
•• Generating Margin ReportsGenerating Margin Reports
•• Analyzing Inventory TransactionsAnalyzing Inventory Transactions
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Inventory Distribution InquiryInventory Distribution Inquiry

Use the Material Transaction Distributions window to:
• Review the accounting distributions of your

material transactions
• Analyze the accounting impact of your material

transactions

Use the Material Transaction Distributions window to:
• Review the accounting distributions of your

material transactions
• Analyze the accounting impact of your material

transactions

Inquiries and analysisInquiries and analysisMaterial  transactionsMaterial  transactions
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Inventory Distribution InquiryInventory Distribution Inquiry

Use the Account Tab of the Material Transaction
Distributions window to view:
• Transaction date
• Account distributions associated with your material

transactions performed within a date range
• Accounting distribution values in the functional

currency of the organization
• Transacted item
• Accounting type for each accounting entry

associated with your material transactions
(N) INV Transactions > Material Transactions >

Find Material Transactions (B) Distributions (T) Account
(N) CST View Transactions > Material Distributions

Use the Account Tab of the Material Transaction
Distributions window to view:
• Transaction date
• Account distributions associated with your material

transactions performed within a date range
• Accounting distribution values in the functional

currency of the organization
• Transacted item
• Accounting type for each accounting entry

associated with your material transactions
(N) INV Transactions > Material Transactions >

Find Material Transactions (B) Distributions (T) Account
(N) CST View Transactions > Material Distributions

(Help) Oracle Manufacturing Applications > Oracle Inventory >
Transactions > Viewing Material Transaction Distributions
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Inventory Distribution InquiryInventory Distribution Inquiry

Use the Type Tab of the Material Transaction
Distributions window to view:
• Transaction type associated with your material

transactions performed within a date range
• Source type for your transactions, showing the

origin of the inventory transaction, like purchase
order, sales order, or account

• Source of your transactions, such as purchase
order number, sales order number, or account
number

• Primary UOM of the item and transaction quantity in
the primary UOM of the item

(N) INV Transactions > Material Transactions >
Find Material Transactions (B) Distributions (T) Type

(N) CST View Transactions > Material Distributions

Use the Type Tab of the Material Transaction
Distributions window to view:
• Transaction type associated with your material

transactions performed within a date range
• Source type for your transactions, showing the

origin of the inventory transaction, like purchase
order, sales order, or account

• Source of your transactions, such as purchase
order number, sales order number, or account
number

• Primary UOM of the item and transaction quantity in
the primary UOM of the item

(N) INV Transactions > Material Transactions >
Find Material Transactions (B) Distributions (T) Type

(N) CST View Transactions > Material Distributions

(Help) Oracle Manufacturing Applications > Oracle Inventory >
Transactions > Viewing Material Transaction Distributions
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Inventory Distribution InquiryInventory Distribution Inquiry

Use the Location Tab of the Material Transaction
Distributions window to determine the subinventory
and locator for your transactions performed within a
date range and to view:
• Subinventory name associated with the transaction
• Location information
• Operation sequence associated with the transaction
• Transaction number assigned to the transaction

(N) INV Transactions > Material Transactions >
Find Material Transactions (B) Distributions (T) Location

(N) CST View Transactions > Material Distributions

Use the Location Tab of the Material Transaction
Distributions window to determine the subinventory
and locator for your transactions performed within a
date range and to view:
• Subinventory name associated with the transaction
• Location information
• Operation sequence associated with the transaction
• Transaction number assigned to the transaction

(N) INV Transactions > Material Transactions >
Find Material Transactions (B) Distributions (T) Location

(N) CST View Transactions > Material Distributions

(Help) Oracle Manufacturing Applications > Oracle Inventory >
Transactions > Viewing Material Transaction Distributions
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Inventory Distribution InquiryInventory Distribution Inquiry

Use the Currency Tab of the Material Transaction
Distributions window to view:
• Exchange rate information for your transactions

performed within a date range
• Transaction date
• Transaction currency
• Distribution value in the transaction currency
• Transaction exchange rate
• Transaction conversion type
(N) INV Transactions > Material Transactions >

Find Material Transactions (B) Distributions (T) Currency
(N) CST View Transactions > Material Distributions

Use the Currency Tab of the Material Transaction
Distributions window to view:
• Exchange rate information for your transactions

performed within a date range
• Transaction date
• Transaction currency
• Distribution value in the transaction currency
• Transaction exchange rate
• Transaction conversion type
(N) INV Transactions > Material Transactions >

Find Material Transactions (B) Distributions (T) Currency
(N) CST View Transactions > Material Distributions

(Help) Oracle Manufacturing Applications > Oracle Inventory >
Transactions > Viewing Material Transaction Distributions
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Inventory Distribution InquiryInventory Distribution Inquiry

Use the Comments Tab of the Material Transaction
Distributions window to view:
• Comments for transactions performed within a date

range
• Transaction information, such as transaction

reason, transaction reference, and general ledger
batch ID (if transferred to the general ledger)

(N) INV Transactions > Material Transactions >
Find Material Transactions (B) Distributions (T) Comments

(N) CST View Transactions > Material Distributions

Use the Comments Tab of the Material Transaction
Distributions window to view:
• Comments for transactions performed within a date

range
• Transaction information, such as transaction

reason, transaction reference, and general ledger
batch ID (if transferred to the general ledger)

(N) INV Transactions > Material Transactions >
Find Material Transactions (B) Distributions (T) Comments

(N) CST View Transactions > Material Distributions

(Help) Oracle Manufacturing Applications > Oracle Inventory >
Transactions > Viewing Material Transaction Distributions
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• Overview of Analyzing Inventory Transactions
• Inventory Distribution Inquiry
• Resubmit Errored Transactions for Costing
• Generating Margin Reports
• Analyzing Inventory Transactions

•• Overview of Analyzing Inventory TransactionsOverview of Analyzing Inventory Transactions
•• Inventory Distribution InquiryInventory Distribution Inquiry
• Resubmit Errored Transactions for Costing
•• Generating Margin ReportsGenerating Margin Reports
•• Analyzing Inventory TransactionsAnalyzing Inventory Transactions
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Resubmitting Errored Transactions for
Costing

Resubmitting Errored Transactions for
Costing

  

ResubmitResubmit

Cost manager concurrent programCost manager concurrent program

Costing at standardCosting at standard
or at averageor at average

ErroredErrored transactions transactions

–X

• After you correct the sources of errors in other
windows, you can resubmit errored material
transactions for costing in the Cost View Material
Transactions window in standard or average
costing environments.

• After you correct the sources of errors in other
windows, you can  you can resubmit errored material
transactions for costing in the Cost View Material
Transactions window in standard or average
costing environments.
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Resubmitting Errored Transactions for
Costing

Resubmitting Errored Transactions for
Costing

Timely Costed Transactions
• You can resubmit errored transactions and cost

transactions on a timely basis. Timely costed
transactions are important:
– To provide up-to-date cost information to

management
– To allow on-time period closing

• Failed transactions must be resolved promptly.
This is particularly critical for average costing
because no further transactions will be costed for
an entire organization if there is a single failed
transaction.

Timely Costed Transactions
• You can resubmit errored transactions and cost

transactions on a timely basis. Timely costed
transactions are important:
– To provide up-to-date cost information to

management
– To allow on-time period closing

• Failed transactions must be resolved promptly.
This is particularly critical for average costing
because no further transactions will be costed for
an entire organization if there is a single failed
transaction.
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Resubmitting Errored Material
Transactions for Costing

Resubmitting Errored Material
Transactions for Costing

Use the Cost View Material Transactions window to:
• View transactions that were not costed

successfully in either standard or average costing
organizations

• Submit cost transactions that have failed to
process

• Identify the error, fix the source of the error using
other windows, and resubmit the transaction using
the error code and error explanation columns,
selecting and submiting the transaction from the
Tools pull-down menu

(N) CST View Transactions > Material Transactions >
Find Material Transactions

Use the Cost View Material Transactions window to:
• View transactions that were not costed

successfully in either standard or average costing
organizations

• Submit cost transactions that have failed to
process

• Identify the error, fix the source of the error using
other windows, and resubmit the transaction using
the error code and error explanation columns,
selecting and submiting the transaction from the
Tools pull-down menu

(N) CST View Transactions > Material Transactions >
Find Material Transactions

(Help) Oracle Manufacturing Applications > Oracle Inventory >
Transactions > Viewing Material Transactions
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Resubmitting Errored Resource
Transactions for Costing

Resubmitting Errored Resource
Transactions for Costing

Use the Pending Resource Transactions window to:
• Select a single transaction or multiple transactions

from the displayed transactions to resubmit for
reprocessing

1.  In the Pending Resource Transactions window,
from the Tools pull-down menu, choose Select All
for Resubmit. You can deselect selected
transactions as required.

2.  Save your work to resubmit the transactions.
(N) CST View Transactions > Pending Resource Transactions >

Find Resource Transactions (T) Comments
(M) Tools > Select All for Resubmit

Use the Pending Resource Transactions window to:
• Select a single transaction or multiple transactions

from the displayed transactions to resubmit for
reprocessing

1.  In the Pending Resource Transactions window,
from the Tools pull-down menu, choose Select All
for Resubmit. You can deselect selected
transactions as required.

2.  Save your work to resubmit the transactions.
(N) CST View Transactions > Pending Resource Transactions >

Find Resource Transactions (T) Comments
(M) Tools > Select All for Resubmit

(Help) Oracle Manufacturing Applications > Oracle WIP >
Transactions > Viewing Resource Transactions
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Resubmitting Errored Transactions for
Costing

Resubmitting Errored Transactions for
Costing

Error Messages
• At resubmission time, you see messages with

meaningful information about the errored
transactions:
– For standard costing
– For average costing

Error Messages
• At resubmission time, you see messages with

meaningful information about the errored
transactions:
– For standard costing
– For average costing

MessagesMessages



Copyright © Oracle Corporation, 2000. All rights reserved.

Analyzing Inventory Transactions
Chapter 1 - Page 19

Resubmitting Errored Transactions for Costing
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Resubmitting Errored Transactions for
Costing

Resubmitting Errored Transactions for
Costing

Standard Costing Error Messages
• Error in localized costing
• Error in getting currency conversion type profile

option
• Error in converting unit of measures for cost
• Error in converting unit of measures for quantity
• Error in getting concurrent who information from

user profile
• Error in computing scrap value
• Error in getting operating unit
• Error processing continuous flow manufacturing

(CFM) completion

Standard Costing Error Messages
• Error in localized costing
• Error in getting currency conversion type profile

option
• Error in converting unit of measures for cost
• Error in converting unit of measures for quantity
• Error in getting concurrent who information from

user profile
• Error in computing scrap value
• Error in getting operating unit
• Error processing continuous flow manufacturing

(CFM) completion
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Resubmitting Errored Transactions for Costing
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Resubmitting Errored Transactions for
Costing

Resubmitting Errored Transactions for
Costing

Average Costing Error Messages
• Creating a row in WIP_PERIOD_BALANCE failed
• Failed in WIP completion or scrap transaction
• Backflush transaction failed

Average Costing Error Messages
• Creating a row in WIP_PERIOD_BALANCE failed
• Failed in WIP completion or scrap transaction
• Backflush transaction failed

MessagesMessages
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Review QuestionReview Question

Failed transactions must be resolved promptly for
average costing because no further transactions will
be costed for an entire organization if there is a single
failed transaction.
1. True
2. False

Failed transactions must be resolved promptly for
average costing because no further transactions will
be costed for an entire organization if there is a single
failed transaction.
1. True
2. False
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Review QuestionReview Question

Failed transactions must be resolved promptly for
average costing because no further transactions will
be costed for an entire organization if there is a single
failed transaction.
1. True
2. False

Failed transactions must be resolved promptly for
average costing because no further transactions will
be costed for an entire organization if there is a single
failed transaction.
1. True
2. False2. False
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AgendaAgenda

• Overview of Analyzing Inventory Transactions
• Inventory Distribution Inquiry
• Resubmit Errored Transactions for Costing
• Generating Margin Reports
• Analyzing Inventory Transactions

•• Overview of Analyzing InventoryOverview of Analyzing Inventory TransactionsTransactions
•• Inventory Distribution InquiryInventory Distribution Inquiry
•• ResubmitResubmit Errored Errored Transactions for Costing Transactions for Costing
• Generating Margin Reports
•• Analyzing Inventory TransactionsAnalyzing Inventory Transactions
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Margin Analysis Reports
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Margin Analysis ReportsMargin Analysis Reports

• Use the Margin Analysis Reports to report sales
revenue, cost of goods sold, and gross margin
information for each item shipped/invoiced within
the specified date range.

• You can print reports in summary and in detail.
– The detail report provides information by

customer, order, and line number.
• The costing method of the organization is

independent of margin analysis reporting or any of
the margin analysis concepts. The costing method
does not affect the procedure to run margin
analysis reports.

• Use the Margin Analysis Reports to report sales
revenue, cost of goods sold, and gross margin
information for each item shipped/invoiced within
the specified date range.

• You can print reports in summary and in detail.
– The detail report provides information by

customer, order, and line number.
• The costing method of the organization is

independent of margin analysis reporting or any of
the margin analysis concepts. The costing method
does not affect the procedure to run margin
analysis reports.
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Margin Analysis Reporting Concepts

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Margin Analysis Reporting ConceptsMargin Analysis Reporting Concepts

You have two Margin Analysis Reports which provide
the same detail:
• Margin Analysis Report

– Uses builds (also known as margin analysis
load runs) in which costs are saved to generate
margin reports

– Provides backward compatibility, allowing you
to create reports from old builds

• Upgrade customers may continue to run reports
from old builds, however, they cannot create any
new builds. The old builds are retained until the
builds are deliberately purged by name, one at a
time.

You have two Margin Analysis Reports which provide
the same detail:
• Margin Analysis Report

– Uses builds (also known as margin analysis
load runs) in which costs are saved to generate
margin reports

– Provides backward compatibility, allowing you
to create reports from old builds

• Upgrade customers may continue to run reports
from old builds, however, they cannot create any
new builds. The old builds are retained until the
builds are deliberately purged by name, one at a
time.
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Margin Analysis Reporting Concepts
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Margin Analysis Reporting ConceptsMargin Analysis Reporting Concepts

Margin Analysis Report with Order Management
• Margin Analysis Report with Order Management

– Uses a continuous build that only uses
transactional costs

– Generates a margin analysis from a cost type
– Uses intelligent dates; no need to purge builds

• This report cannot be generated from old builds
because the build name does not appear in the
report parameters.

Margin Analysis Report with Order Management
• Margin Analysis Report with Order Management

– Uses a continuous build that only uses
transactional costs

– Generates a margin analysis from a cost type
– Uses intelligent dates; no need to purge builds

• This report cannot be generated from old builds
because the build name does not appear in the
report parameters.
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Margin Analysis Reporting Concepts
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Margin Analysis Reporting ConceptsMargin Analysis Reporting Concepts

Implications
• In Release 11, you could save costs by saving

builds.
• In Release 11i, you need to save a specific cost

type, other than the transactional cost type, in
order to be able to rerun a margin analysis against
that cost type.

• For example, it you have target cost types for
different years, you need to save each target cost
type in order to be able to run a margin analysis
report against target costs from different years.

Implications
• In Release 11, you could save costs by saving

builds.
• In Release 11i, you need to save a specific cost

type, other than the transactional cost type, in
order to be able to rerun a margin analysis against
that cost type.

• For example, it you have target cost types for
different years, you need to save each target cost
type in order to be able to run a margin analysis
report against target costs from different years.
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Reports
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Margin Analysis Reporting Concepts for
Both Margin Reports

Margin Analysis Reporting Concepts for
Both Margin Reports

Multi–org
• If you enable Multi–org, the Margin Analysis Reports

display sales revenue, cost of goods sold, and gross
margin information for all inventory organizations
within an operating unit.

• If you do not enable Multi–org , the Margin Analysis
Reports display sales revenue, cost of goods sold,
and gross margin information for the operating unit
in which the current organization belongs.

Multi–org
• If you enable Multi–org, the Margin Analysis Reports

display sales revenue, cost of goods sold, and gross
margin information for all inventory organizations
within an operating unit.

• If you do not enable Multi–org , the Margin Analysis
Reports display sales revenue, cost of goods sold,
and gross margin information for the operating unit
in which the current organization belongs.
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Margin Analysis Reporting Concepts for Both Margin
Reports
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Margin Analysis Reporting Concepts for
Both Margin Reports

Margin Analysis Reporting Concepts for
Both Margin Reports

Marketing Parameters
• You can combine the Customer Name, Sales

Representative, Sales Channel, and Industry
parameters to restrict the report to a single
customer, sales representative, sales channel, and
industry.

Cost of Goods Sold
• Cost of goods is displayed at the historical

transaction cost unless you enter a value in the
cost type parameter. If you enter a cost type, cost
of goods sold is calculated by extending the
quantity shipped times the current item cost in the
chosen cost type.

Marketing Parameters
• You can combine the Customer Name, Sales

Representative, Sales Channel, and Industry
parameters to restrict the report to a single
customer, sales representative, sales channel, and
industry.

Cost of Goods Sold
• Cost of goods is displayed at the historical

transaction cost unless you enter a value in the
cost type parameter. If you enter a cost type, cost
of goods sold is calculated by extending the
quantity shipped times the current item cost in the
chosen cost type.
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Generating Margin Analysis ReportsGenerating Margin Analysis Reports

Use the Margin Analysis Report or the Margin Analysis
Report with Order Management (OM) to:
• Report sales revenue, cost of goods sold, and gross

margin information for each item shipped and
invoiced within a specified date range.

• In the Submit Requests window, you select the
report name.

(N) CST Report  > Operational Analysis > Request Analysis Reports

Use the Margin Analysis Report or the Margin Analysis
Report with Order Management (OM) to:
• Report sales revenue, cost of goods sold, and gross

margin information for each item shipped and
invoiced within a specified date range.

• In the Submit Requests window, you select the
report name.

(N) CST Report  > Operational Analysis > Request Analysis Reports

ReportsReports

(Help) Oracle Manufacturing Applications > Oracle Inventory >
Reports and Processes > Margin Analysis Report
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Prerequisites
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Margin Analysis Report for Order
Management, Prerequisites

Margin Analysis Report for Order
Management, Prerequisites

• If you are missing one of these applications, you
cannot run the report:
– Oracle Order Management (OM)
– Oracle Inventory
– Oracle Receivables

• In addition, for accurate margin reporting, in
Receivables, use the derived date option to set
invoice dates:
– The invoice date automatically defaults to the

shipment date.
– You recognize revenue and cost in the same

accounting period.

• If you are missing one of these applications, you
cannot run the report:
– Oracle Order Management (OM)
– Oracle Inventory
– Oracle Receivables

• In addition, for accurate margin reporting, in
Receivables, use the derived date option to set
invoice dates:
– The invoice date automatically defaults to the

shipment date.
– You recognize revenue and cost in the same

accounting period.
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Margin Analysis Report for Order Management,
Prerequisites
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Margin Analysis Report for Order
Management, Prerequisites

Margin Analysis Report for Order
Management, Prerequisites

• You run this report from tables populated by
submission of the Margin Analysis Load Run
program.
– The first time that this program runs under

Order Management, it populates empty tables.
– Subsequent submission of the program

appends data to the tables, but the tables are
never purged. A continuous build is created.

• Since the continuous build is based on valuation
cost types (standard or average), the cost type is
selected when you submit the report. You cannot
purge continuous builds.

• You run this report from tables populated by
submission of the Margin Analysis Load Run
program.
– The first time that this program runs under

Order Management, it populates empty tables.
– Subsequent submission of the program

appends data to the tables, but the tables are
never purged. A continuous build is created.

• Since the continuous build is based on valuation
cost types (standard or average), the cost type is
selected when you submit the report. You cannot
purge continuous builds.



Copyright © Oracle Corporation, 2000. All rights reserved.

Analyzing Inventory Transactions
Chapter 1 - Page 33

Submitting a Margin Analysis Load Run

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Submitting a Margin Analysis Load RunSubmitting a Margin Analysis Load Run

• You must run the Margin Analysis Load Run
program in order to create the build from which
Margin Analysis reports are derived.

• When you upgraded to Release 11i with Order
Management, all the Order Entry data was
migrated to Order Management tables, allowing
you to create a new margin build.

• You create this new margin build the first time that
you run the Margin Analysis Load Run program.

• Subsequently, you rerun the Margin Analysis Load
Run program to increment or refresh the build.

• You must run the Margin Analysis Load Run
program in order to create the build from which
Margin Analysis reports are derived.

• When you upgraded to Release 11i with Order
Management, all the Order Entry data was
migrated to Order Management tables, allowing
you to create a new margin build.

• You create this new margin build the first time that
you run the Margin Analysis Load Run program.

• Subsequently, you rerun the Margin Analysis Load
Run program to increment or refresh the build.

Note
When Oracle Order Management is installed, the Margin Analysis Load Run (or
Build) tables are continuous and ongoing. The build cannot be purged.
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Submitting a Margin Analysis Load RunSubmitting a Margin Analysis Load Run

After “loading” data generated by transactions, you
can run the Margin Analysis Reports.
Use the Margin Analysis Load Run window to:
• Load data from a series of transactions have been

performed
• Enter parameters:

– From date
– To date
– Overlap days
– Load Option: increment or refresh

(N) CST Report  > Operational Analysis >
Request Analysis Reports > Margin Analysis Load Run

After “loading” data generated by transactions, you
can run the Margin Analysis Reports.
Use the Margin Analysis Load Run window to:
• Load data from a series of transactions have been

performed
• Enter parameters:

– From date
– To date
– Overlap days
– Load Option: increment or refresh

(N) CST Report  > Operational Analysis >
Request Analysis Reports > Margin Analysis Load Run

(Help) Oracle Manufacturing Applications > Oracle Inventory >
Reports and Processes > Margin Analysis Load Run
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Loading Data for Margin Analysis Report
for a Regular Order with a Standard Item
Loading Data for Margin Analysis Report
for a Regular Order with a Standard Item

Business Flow
• Create an order (header and line) for a standard item.
• Create an invoice for that item with AutoInvoice.
• Ensure that the corresponding revenue distribution is

created.
• Pick release the order.
• Ship the item (Ship Confirm Deliveries and Update

Shipping) and cost it (Cost manager up).
• Run INV interface and AR interface to syncronize INV,

OM and AR.
• Ensure that COGS accounting distribution is created.
• Repeat the above bullets with an order with multiple

lines and multiple standard items.
• Run the Margin Analysis Load program and check

table CST_MARGIN_TEMP for results.

Business Flow
• Create an order (header and line) for a standard item.
• Create an invoice for that item with AutoInvoice.
• Ensure that the corresponding revenue distribution is

created.
• Pick release the order.
• Ship the item (Ship Confirm Deliveries and Update

Shipping) and cost it (Cost manager up).
• Run INV interface and AR interface to syncronize INV,

OM and AR.
• Ensure that COGS accounting distribution is created.
• Repeat the above bullets with an order with multiple

lines and multiple standard items.
• Run the Margin Analysis Load program and check

table CST_MARGIN_TEMP for results.
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Purging a Margin Analysis Load RunPurging a Margin Analysis Load Run

Use the Purge Margin Analysis Run window to:
• Enter the load name to purge the build generated

prior to Release 11i with Oracle Order Management
• Enter parameters:

– Build Name
– Build Description
– From date
– To date
– Order Number
– Cost Type

(N) CST Report  > Operational Analysis >
Request Analysis Reports > Purge Margin Analysis Run

Use the Purge Margin Analysis Run window to:
• Enter the load name to purge the build generated

prior to Release 11i with Oracle Order Management
• Enter parameters:

– Build Name
– Build Description
– From date
– To date
– Order Number
– Cost Type

(N) CST Report  > Operational Analysis >
Request Analysis Reports > Purge Margin Analysis Run

(Help) Oracle Manufacturing Applications > Oracle Inventory >
Reports and Processes > Purge Margin Analysis Run
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Review QuestionReview Question

The Margin Analysis Report with Order Management
cannot be generated from old builds because the
build name does not appear in the report parameters.
The Margin Analysis Report provides backward
compatibility to upgrade customers, since you can
create margin reports from old builds.
1. True
2. False

The Margin Analysis Report with Order Management
cannot be generated from old builds because the
build name does not appear in the report parameters.
The Margin Analysis Report provides backward
compatibility to upgrade customers, since you can
create margin reports from old builds.
1. True
2. False
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Review QuestionReview Question

The Margin Analysis Report with Order Management
cannot be generated from old builds because the
build name does not appear in the report parameters.
The Margin Analysis Report provides backward
compatibility to upgrade customers, since you can
create margin reports from old builds.
1. True
2. False

The Margin Analysis Report with Order Management
cannot be generated from old builds because the
build name does not appear in the report parameters.
The Margin Analysis Report provides backward
compatibility to upgrade customers, since you can
create margin reports from old builds.
1. True
2. False2. False
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AgendaAgenda

• Overview of Analyzing Inventory Transactions
• Inventory Distribution Inquiry
• Resubmit Errored Transactions for Costing
• Generating Margin Reports
• Analyzing Inventory Transactions

•• Overview of Analyzing InventoryOverview of Analyzing Inventory TransactionsTransactions
•• Inventory Distribution InquiryInventory Distribution Inquiry
•• ResubmitResubmit Errored Errored Transactions for Costing Transactions for Costing
•• Generating Margin ReportsGenerating Margin Reports
• Analyzing Inventory Transactions



Copyright © Oracle Corporation, 2000. All rights reserved.

Analyzing Inventory Transactions
Chapter 1 - Page 40

Account Distribution Reports

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Account Distribution ReportsAccount Distribution Reports

• Receiving Account Distribution Report
• Material Account Distribution Detail Report
• Transaction Historical Summary Report
• Purchase Price Variance Report
• Invoice Price Variance Report

• Receiving Account Distribution Report
• Material Account Distribution Detail Report
• Transaction Historical Summary Report
• Purchase Price Variance Report
• Invoice Price Variance Report
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Account Distribution ReportsAccount Distribution Reports

Receiving Account Distribution Report
• Use the Receiving Account Distribution Report to

display accounting information associated with
your receiving transactions.

(N) CST Report  > Transactions > Request Transaction Reports

Receiving Account Distribution Report
• Use the Receiving Account Distribution Report to

display accounting information associated with
your receiving transactions.

(N) CST Report  > Transactions > Request Transaction Reports

(Help) Oracle Manufacturing Applications > Oracle Inventory >
Reports and Processes > Receiving Account Distribution Report
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Account Distribution ReportsAccount Distribution Reports

Material Account Distribution Detail Report
• You can review inventory transaction values

transferred to the general ledger by GL batch to
aid in your inventory to general ledger
reconciliation.
– Select a specific GL batch and report only the

entries transferred in that batch.

Material Account Distribution Detail Report
• You can review inventory transaction values

transferred to the general ledger by GL batch to
aid in your inventory to general ledger
reconciliation.
– Select a specific GL batch and report only the

entries transferred in that batch.
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Submitting the Material Account Distribution Detail
Report
• Use the Material Account Distribution Detail

Report to display accounting information
associated with your inventory transactions.

(N) CST Report  > Transactions > Request Transaction Reports

1.  Use the Transaction Reports, Cost and Period
Close Reports, or Submit Requests window and
enter “Material account distribution detail” in the
Name field to submit the report.

2.  Enter the report parameters.
3.  Submit the report.

Submitting the Material Account Distribution Detail
Report
• Use the Material Account Distribution Detail

Report to display accounting information
associated with your inventory transactions.

(N) CST Report  > Transactions > Request Transaction Reports

1.  Use the Transaction Reports, Cost and Period
Close Reports, or Submit Requests window and
enter “Material account distribution detail” in the
Name field to submit the report.

2.  Enter the report parameters.
3.  Submit the report.

(Help) Oracle Manufacturing Applications > Oracle Inventory >
Reports and Processes >
Material Account Distribution Detail Report
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Transaction Historical
Summary Report

Transaction Historical
Summary Report

Rollback Transaction Quantities and Values
• Rollback transaction quantities and values to any

date you choose and report the beginning balance
and the transaction values.

Multiple Open Periods
• When you have multiple periods, you can use this

report to determine the inventory quantity or value
as of the end date of your prior periods using the
balance option of the report.

Throughput Analysis
• You can analyze the quantity and value throughput

using the quantity or value options of the report.

Rollback Transaction Quantities and Values
• Rollback transaction quantities and values to any

date you choose and report the beginning balance
and the transaction values.

Multiple Open Periods
• When you have multiple periods, you can use this

report to determine the inventory quantity or value
as of the end date of your prior periods using the
balance option of the report.

Throughput Analysis
• You can analyze the quantity and value throughput

using the quantity or value options of the report.



Copyright © Oracle Corporation, 2000. All rights reserved.

Analyzing Inventory Transactions
Chapter 1 - Page 45

Transaction Historical Summary Report

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Transaction Historical
Summary Report

Transaction Historical
Summary Report

• Use the Transaction Historical Summary Report to
analyze historical item quantities, values, or
historical inventory balances.

(N) CST Report  > Transactions > Request Transaction Reports

• Use the Transaction Historical Summary Report to
analyze historical item quantities, values, or
historical inventory balances.

(N) CST Report  > Transactions > Request Transaction Reports

ValuesValuesBalancesBalances Audit trailAudit trail
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Inventory Input/Output AnalysisInventory Input/Output Analysis

Beginning balance + sources - uses = Ending balanceBeginning balance + sources - uses = Ending balance

Inventory flowInventory flow

Material Account Distribution Reports
• You can analyze the sources and uses of your

inventory using the material account distribution
reports run by transaction type or source type.

Material Account Distribution Reports
• You can analyze the sources and uses of your

inventory using the material account distribution
reports run by transaction type or source type.
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Inventory Input/Output AnalysisInventory Input/Output Analysis

Sources
• Purchase order receipts
• WIP completions
• Interorganization receipts
• Miscellaneous receipts
Uses
• Customer shipments
• WIP issues
• Interorganization issues
• Miscellaneous issues

Sources
• Purchase order receipts
• WIP completions
• Interorganization receipts
• Miscellaneous receipts
Uses
• Customer shipments
• WIP issues
• Interorganization issues
• Miscellaneous issues
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Analyzing PPV/IPVAnalyzing PPV/IPV

Purchase Price Variance (PPV)
• PPV only applies to standard costing organizations.
• Each time you deliver material from a purchase order

to a subinventory, the PO price is compared to the
standard cost of the item and a variance is calculated.

• Average cost organizations are valued at purchase
price and have no PPV, except with outside
processing which is charged at standard cost in
an average cost organization.

Purchase Price Variance (PPV)
• PPV only applies to standard costing organizations.
• Each time you deliver material from a purchase order

to a subinventory, the PO price is compared to the
standard cost of the item and a variance is calculated.

• Average cost organizations are valued at purchase
price and have no PPV, except with outside
processing which is charged at standard cost in
an average cost organization.
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Analyzing PPV/IPVAnalyzing PPV/IPV

Invoice Price Variance (IPV)
• IPV applies to both standard costing and average

costing organizations.
• Each time an invoice is matched (approved) to a

purchase order, the invoice price is compared to the
PO price and a variance is calculated.

• IPV is calculated when the Payables Accounting
Process is run, not when the invoice is matched.

Invoice Price Variance (IPV)
• IPV applies to both standard costing and average

costing organizations.
• Each time an invoice is matched (approved) to a

purchase order, the invoice price is compared to the
PO price and a variance is calculated.

• IPV is calculated when the Payables Accounting
Process is run, not when the invoice is matched.
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Use the Purchase Price Variance Report to:
• Analyze purchase price variance (PPV)
(N) CST Report  > Operational Analysis > Request Analysis Reports

Use the Invoice Price Variance Report to:
• Analyze invoice price variance (IPV)
(N) CST Report  > Operational Analysis > Request Analysis Reports

Use the Purchase Price Variance Report to:
• Analyze purchase price variance (PPV)
(N) CST Report  > Operational Analysis > Request Analysis Reports

Use the Invoice Price Variance Report to:
• Analyze invoice price variance (IPV)
(N) CST Report  > Operational Analysis > Request Analysis Reports
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Review QuestionReview Question

You can analyze the sources and uses of your
inventory using the material account distribution
reports run by transaction type or source type.
1. True
2. False

You can analyze the sources and uses of your
inventory using the material account distribution
reports run by transaction type or source type.
1. True
2. False
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Review QuestionReview Question

You can analyze the sources and uses of your
inventory using the material account distribution
reports run by transaction type or source type.
1. True
2. False

You can analyze the sources and uses of your
inventory using the material account distribution
reports run by transaction type or source type.
1. True
2. False2. False
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In this lesson, you should have learned how to:
• Use inventory distribution inquiries and reports
• Resubmit errored transactions
• Use margin analysis reports
• Use inventory distribution reports
• Perform inventory input/output analysis
• Analyze purchase price variance (PPV) and invoice

price variance (IPV)

In this lesson, you should have learned how to:
• Use inventory distribution inquiries and reports
• Resubmit errored transactions
• Use margin analysis reports
• Use inventory distribution reports
• Perform inventory input/output analysis
• Analyze purchase price variance (PPV) and invoice

price variance (IPV)
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Practice 1 OverviewPractice 1 Overview

This practice covers the following topics:
• Reviewing inventory transaction analysis
• Performing and analyzing inventory transactions

This practice covers the following topics:
• Reviewing inventory transaction analysis
•• Performing and analyzing inventory transactionsPerforming and analyzing inventory transactions
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Practice 1-1Practice 1-1

Reviewing Inventory Transaction Analysis
1.  Which window do you use to determine the

transaction currency, conversion rate, and
conversion rate type for your inventory
transactions?

2.  What are the sources and uses of inventory?
3.  What formula is used to calculate the ending

inventory balance?

Reviewing Inventory Transaction Analysis
1.  Which window do you use to determine the

transaction currency, conversion rate, and
conversion rate type for your inventory
transactions?

2.  What are the sources and uses of inventory?
3.  What formula is used to calculate the ending

inventory balance?
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Practice 1-1 SolutionPractice 1-1 Solution

Reviewing Inventory Transaction Analysis
1.  Which window do you use to determine the

transaction currency, conversion rate, and
conversion rate type for your inventory
transactions?
Use the Currency region of the View Transaction
Distributions window to determine the transaction
currency, conversion rate, and conversion rate
type.

Reviewing Inventory Transaction Analysis
1.  Which window do you use to determine the

transaction currency, conversion rate, and
conversion rate type for your inventory
transactions?
Use the Currency region of the View Transaction
Distributions window to determine the transaction
currency, conversion rate, and conversion rate
type.
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Practice 1-1: SolutionPractice 1-1: Solution

Reviewing Inventory Transaction Analysis
2.  What are the sources and uses of inventory?

Sources: PO Receipts, Interorg Receipts, Receipts
from WIP, Misc. Receipts
Uses: Issues to WIP, interorg transfers, sales order
shipments, cost update, miscellaneous issues

3.  What formula is used to calculate the ending
inventory balance?
Ending inventory = Beginning inventory + sources
– uses

Reviewing Inventory Transaction Analysis
2.  What are the sources and uses of inventory?

Sources: PO Receipts, Interorg Receipts, Receipts
from WIP, Misc. Receipts
Uses: Issues to WIP, interorg transfers, sales order
shipments, cost update, miscellaneous issues

3.  What formula is used to calculate the ending
inventory balance?
Ending inventory = Beginning inventory + sources
– uses



Copyright © Oracle Corporation, 2000. All rights reserved.

Analyzing Inventory Transactions
Chapter 1 - Page 58

Practice 1-2: Performing and Analyzing Inventory
Transactions

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice 1-2: Performing and Analyzing
Inventory Transactions

Practice 1-2: Performing and Analyzing
Inventory Transactions

In this practice, you are a buyer and will be doing the
following in the screens that follow:
1.  Verify that the transaction processor is running.
2.  Verify that the current period is open.
3.  Create a purchase order for CM22680.
4.  Approve your purchase order and receive goods.
5.  View accounting entries.
6.  Perform an inventory adjustment for CM22682 using
a miscellaneous receipt.
7.  View accounting entries.
8.  Run the Material Account Distribution Detail Report.
9.  Run the Purchase Price Variance Report.

In this practice, you are a buyer and will be doing the
following in the screens that follow:
1.  Verify that the transaction processor is running.
2.  Verify that the current period is open.
3.  Create a purchase order for CM22680.
4.  Approve your purchase order and receive goods.
5.  View accounting entries.
6.  Perform an inventory adjustment for CM22682 using
a miscellaneous receipt.
7.  View accounting entries.
8.  Run the Material Account Distribution Detail Report.
9.  Run the Purchase Price Variance Report.
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Guided Practice 1-2: Checking the
Inferface Managers

Guided Practice 1-2: Checking the
Inferface Managers

1.  Navigate to the Interface Managers window in
Seattle, M1, to check the status of the Cost
Manager. If this manager is not running or is
running at an interval greater than 10 minutes,
inform the instructor.

(N) INV Setup > Transactions > Interface Managers

1.  Navigate to the Interface Managers window in
Seattle, M1, to check the status of the Cost
Manager. If this manager is not running or is
running at an interval greater than 10 minutes,
inform the instructor.

(N) INV Setup > Transactions > Interface Managers
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Guided Practice 1-2: Checking Current
Period is Open

Guided Practice 1-2: Checking Current
Period is Open

1.  Navigate to the Inventory Accounting Periods
window to check that the current period is open. If
it is not open, open it and all preceding unopened
periods.

(N) INV Accounting Close Cycle > Inventory Accounting Periods

1.  Navigate to the Inventory Accounting Periods
window to check that the current period is open. If
it is not open, open it and all preceding unopened
periods.

(N) INV Accounting Close Cycle > Inventory Accounting Periods
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Guided Practice 1-2: Creating Purchase
Orders

Guided Practice 1-2: Creating Purchase
Orders

1.  Navigate to the Purchase Orders window to create a
purchase order for CM22680 in the M1 organization.
Student 10 will use a quantity of 10, and a price of $10.00;
Student 20 will use a quantity of 20, and a price of $20.00;
Student 30 will use a quantity of 30, and a price of $30.00;
and so on.
(N) PURCHASING Purchase Orders > Purchase Orders (New)
2.  Type: Standard Purchase Order
3.  Supplier: Advanced Network Devices
4.  Site: Santa Clara
5.  Ship to: M1
6.  Bill to: Accept default
7.  Buyer: Accept default
8.  Navigate to Items.

1.  Navigate to the Purchase Orders window to create a
purchase order for CM22680 in the M1 organization.
Student 10 will use a quantity of 10, and a price of $10.00;
Student 20 will use a quantity of 20, and a price of $20.00;
Student 30 will use a quantity of 30, and a price of $30.00;
and so on.
(N) PURCHASING Purchase Orders > Purchase Orders (New)
2.  Type: Standard Purchase Order
3.  Supplier: Advanced Network Devices
4.  Site: Santa Clara
5.  Ship to: M1
6.  Bill to: Accept default
7.  Buyer: Accept default
8.  Navigate to Items.
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Guided Practice 1-2: Creating Purchase
Orders

Guided Practice 1-2: Creating Purchase
Orders

1.  Navigate to items (continued from previous page).
(N) PURCHASING Purchase Orders > Purchase Orders (New)
(T) Items
2.  Number: 1
3.  Type: Goods
4.  Item: CM22680
5.  Quantity: 100 for
Student 1, 200 for
Student 2, and so on.
6.  Price: You decide
7.  Promise date: Today
8.  Need by date: Today

1.  Navigate to items (continued from previous page).
(N) PURCHASING Purchase Orders > Purchase Orders (New)
(T) Items
2.  Number: 1
3.  Type: Goods
4.  Item: CM22680
5.  Quantity: 100 for
Student 1, 200 for
Student 2, and so on.
6.  Price: You decide
7.  Promise date: Today
8.  Need by date: Today

      9.  Choose: Shipments
10. Number: 1
11. Org: M1
12. Ship to: M1-Seattle
13. Quantity: Will default
14. Save your work.
15. Record your PO number
      here_________.

      9.  Choose: Shipments
10. Number: 1
11. Org: M1
12. Ship to: M1-Seattle
13. Quantity: Will default
14. Save your work.
15. Record your PO number
      here_________.
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Guided Practice 1-2: Approving Purchase
Orders

Guided Practice 1-2: Approving Purchase
Orders

1. Record your PO number here_________ (continued
from previous page).
2. Choose: Approve.
3. Submit for approval: X
4. Click OK.
You should see a message, “Document has been
submitted for approval”.

1. Record your PO number here_________ (continued
from previous page).
2. Choose: Approve.
3. Submit for approval: X
4. Click OK.
You should see a message, “Document has been
submitted for approval”.



Copyright © Oracle Corporation, 2000. All rights reserved.

Analyzing Inventory Transactions
Chapter 1 - Page 64

Guided Practice 1-2: Receiving Goods to Receiving

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Guided Practice 1-2: Receiving Goods to
Receiving

Guided Practice 1-2: Receiving Goods to
Receiving

1. Navigate to the Receipts window to receive the
goods to receiving, once your purchase order has
been approved.
(N) PURCHASING Receiving > Receipts

2.  Purchase Order: The one you noted earlier
3.  Choose: Find
4.  Enable the box next to the quantity field.
5.  Save your work.

1. Navigate to the Receipts window to receive the
goods to receiving, once your purchase order has
been approved.
(N) PURCHASING Receiving > Receipts

2.  Purchase Order: The one you noted earlier
3.  Choose: Find
4.  Enable the box next to the quantity field.
5.  Save your work.
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Guided Practice 1-2: Receiving Goods to
Subinventory

Guided Practice 1-2: Receiving Goods to
Subinventory

1. Navigate to the Receiving Transactions window to
receive the goods from receiving to inventory.
(N) PURCHASING Receiving > Receipts

2.  Purchase Order: The one you noted earlier
3.  Choose: Find
4.  Enable the box next to the quantity field.
5.  Subinventory: Stores
6.  Save your work.

1. Navigate to the Receiving Transactions window to
receive the goods from receiving to inventory.
(N) PURCHASING Receiving > Receipts

2.  Purchase Order: The one you noted earlier
3.  Choose: Find
4.  Enable the box next to the quantity field.
5.  Subinventory: Stores
6.  Save your work.
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Guided Practice 1-2: Viewing Accounting
Entries

Guided Practice 1-2: Viewing Accounting
Entries

1. Navigate to the Material Transaction Distributions
window, Accounts region, to review the accounting
distributions once you have received the goods.
(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions
2.  Date: Accept the default of today’s date
3.  Item: CM22680
4.  Choose: Find

1. Navigate to the Material Transaction Distributions
window, Accounts region, to review the accounting
distributions once you have received the goods.
(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions
2.  Date: Accept the default of today’s date
3.  Item: CM22680
4.  Choose: Find
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Guided Practice 1-2: Performing
Miscellaneous Receipts

Guided Practice 1-2: Performing
Miscellaneous Receipts

1.  Navigate to the Miscellaneous Transaction window
to perform an inventory adjustment for CM22682
using a miscellaneous receipt.
(N) INV Transactions > Miscellaneous Transaction
2.  Date: Accept the default of today’s date
3.  Type: Select account alias receipt
4.  Source: M1_STD_CST_ADJ
5.  Choose: Transaction Lines
5.  Item: CM22682
6.  Subinventory: Stores
7.  Quantity: Enter a quantity corresponding to your

student number
8.  Action: Save

1.  Navigate to the Miscellaneous Transaction window
to perform an inventory adjustment for CM22682
using a miscellaneous receipt.
(N) INV Transactions > Miscellaneous Transaction
2.  Date: Accept the default of today’s date
3.  Type: Select account alias receipt
4.  Source: M1_STD_CST_ADJ
5.  Choose: Transaction Lines
5.  Item: CM22682
6.  Subinventory: Stores
7.  Quantity: Enter a quantity corresponding to your

student number
8.  Action: Save
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Guided Practice 1-2: Viewing Accounting
Entries

Guided Practice 1-2: Viewing Accounting
Entries

1. Navigate to the Material Transaction Distributions
window, Accounts region, to view the accounting
entries created by the miscellaneous transactions.
(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions
2.  Date: Accept the default of today’s date
3.  Item: CM22682
4.  Choose: Find

1. Navigate to the Material Transaction Distributions
window, Accounts region, to view the accounting
entries created by the miscellaneous transactions.
(N) INV Transactions > Material Transactions (F) Find Material
Transactions (B) Distributions (T) Account

(N) CST View Transactions > Material Distributions
2.  Date: Accept the default of today’s date
3.  Item: CM22682
4.  Choose: Find
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Guided Practice 1-2: Running the Material
Account Distribution Detail Report

Guided Practice 1-2: Running the Material
Account Distribution Detail Report

1.  Navigate to the Request Transaction Reports window
(N) CST Report  > Transactions
2. The Submit a new Request window opens
3. Check Select Single Request and choose OK
4. Name: Material Account Distribution Detail Report
5. Choose: OK
6. Enter parameters:
7. Sort By: Item, Account
8. Transaction Dates From: Today’s date
9. Transaction Dates To: Today’s date
10. Item From/To: CM22680 to CM22682
12. Category Set: Inv.Items
13. Exchange Rate: 1
14. Select OK and choose submit
15.Record your request number ________.

1.  Navigate to the Request Transaction Reports window
(N) CST Report  > Transactions
2. The Submit a new Request window opens
3. Check Select Single Request and choose OK
4. Name: Material Account Distribution Detail Report
5. Choose: OK
6. Enter parameters:
7. Sort By: Item, Account
8. Transaction Dates From: Today’s date
9. Transaction Dates To: Today’s date
10. Item From/To: CM22680 to CM22682
12. Category Set: Inv.Items
13. Exchange Rate: 1
14. Select OK and choose submit
15.Record your request number ________.
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Guided Practice 1-2: Viewing the Results
Online

Guided Practice 1-2: Viewing the Results
Online

1. Navigate to the Requests window to check that
your report request has completed and to view output
online.
(N) CST Setup > Requests (B) View Output

2.  Check Specific Request
3.  Request ID: Enter your request number
4.  Choose: Find
5.  Choose: View Output

1. Navigate to the Requests window to check that
your report request has completed and to view output
online.
(N) CST Setup > Requests (B) View Output

2.  Check Specific Request
3.  Request ID: Enter your request number
4.  Choose: Find
5.  Choose: View Output
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Guided Practice 1-2: Running the
Purchase Price Variance Report

Guided Practice 1-2: Running the
Purchase Price Variance Report

1.  Navigate to the Request Analysis Reports window
(N) CST Report  > Operational Analysis > Request Analysis Reports
2. The Submit a new Request window opens
3. Check Select Single Request and choose OK
4. Name: Purchase Price Variance Report
5. Choose: OK
6. Enter parameters:
7. Title: Purchase Price Variance Report for xxx, where
xxx are your initials
8.  Transaction Dates From: Today’s date
9.  Transaction Dates To: Today’s date
10.  Organization Name: M1 Seattle Manufacturing
11. Select OK and choose submit
12. Record your request number here_________.

1.  Navigate to the Request Analysis Reports window
(N) CST Report  > Operational Analysis > Request Analysis Reports
2. The Submit a new Request window opens
3. Check Select Single Request and choose OK
4. Name: Purchase Price Variance Report
5. Choose: OK
6. Enter parameters:
7. Title: Purchase Price Variance Report for xxx, where
xxx are your initials
8.  Transaction Dates From: Today’s date
9.  Transaction Dates To: Today’s date
10.  Organization Name: M1 Seattle Manufacturing
11. Select OK and choose submit
12. Record your request number here_________.
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Guided Practice 1-2: Viewing the Results
Online

Guided Practice 1-2: Viewing the Results
Online

1. Navigate to the Requests window to check that
your report request has completed and to view output
online.
(N) CST Setup > Requests (B) View Output

2.  Check Specific Request
3.  Request ID: Enter your request number
4.  Choose: Find
5.  Choose: View Output

1. Navigate to the Requests window to check that
your report request has completed and to view output
online.
(N) CST Setup > Requests (B) View Output

2.  Check Specific Request
3.  Request ID: Enter your request number
4.  Choose: Find
5.  Choose: View Output
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Analyzing Inventory and WIP Transactions
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 Analyzing Inventory and WIP
Transactions

 Analyzing Inventory and WIP
Transactions

Analyzing WIP TransactionsAnalyzing WIP Transactions
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ObjectivesObjectives

After completing this lesson, you should be able
to do the following:
• View WIP values online
• Report and analyze WIP values

After completing this lesson, you should be able
to do the following:
• View WIP values online
• Report and analyze WIP values

Inquiries and analysisInquiries and analysis ReportsReports
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AgendaAgenda

• Overview of analyzing WIP transactions
• Viewing Job and Schedule Values Online
• Reporting and Analyzing WIP Values

• Overview of analyzing WIP transactions
•• Viewing Job and Schedule Values OnlineViewing Job and Schedule Values Online
•• Reporting and Analyzing WIP ValuesReporting and Analyzing WIP Values
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Overview

Raw materialRaw material
subinventorysubinventory

Oracle Cost ManagementOracle Cost Management

Jobs and schedulesJobs and schedules
FinishedFinished

assembliesassemblies

The transactions that are processed in Oracle Inventory
and in Oracle WIP are costed in Oracle Cost Management.
The transactions that are processed in Oracle Inventory
and in Oracle WIP are costed in Oracle Cost Management.

FinishedFinished
GoodsGoods

subinventorysubinventory
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OverviewOverview

   ResourcesResources

OSPOSP

 $ $

AssembliesAssemblies

CostCost
IncurredIncurred
($)($)

CostCost
RelievedRelieved
($)($)

NetNet ValueValue ==
IncurredIncurred -- RelievedRelieved

OverheadOverhead

ComponentsComponents

 $ $

 $ $

 $ $

WIPWIP

 $ $

Cost always follows quantityCost always follows quantity
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OverviewOverview

You use various inquiries and reports to help you
analyze the accounting impact of your WIP transactions.
You use various inquiries and reports to help you
analyze the accounting impact of your WIP transactions.

Inquiries and analysisInquiries and analysis ReportsReports
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AgendaAgenda

• Overview of analyzing WIP transactions
• Viewing Job and Schedule Values Online
• Reporting and Analyzing WIP Values

•• Overview of analyzing WIP transactionsOverview of analyzing WIP transactions
• Viewing Job and Schedule Values Online
•• Reporting and Analyzing WIP ValuesReporting and Analyzing WIP Values
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Viewing Job and Schedule Values OnlineViewing Job and Schedule Values Online

Use the WIP Value Summary window, Summary Tab:
• To analyze your jobs and schedules
• To view charges to a specific job or schedule
• To view your work-in-process values by cost

element, and drill down to your accounting
transactions

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
(T) Summary

(N) CST View Transactions > WIP Value Summary (B) Find  >
Value Summary (T) Summary

Use the WIP Value Summary window, Summary Tab:
• To analyze your jobs and schedules
• To view charges to a specific job or schedule
• To view your work-in-process values by cost

element, and drill down to your accounting
transactions

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
(T) Summary

(N) CST View Transactions > WIP Value Summary (B) Find  >
Value Summary (T) Summary

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Windows and Navigations >
Viewing WIP Value Summaries
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Viewing Job and Schedule Values OnlineViewing Job and Schedule Values Online

Use the WIP Value Summary window, Level Tab:
• To view your work-in-process values by level, and

drill down to your accounting transactions

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
(T) Level

(N) CST View Transactions > WIP Value Summary (B) Find  >
Value Summary (T) Level

Use the WIP Value Summary window, Level Tab:
• To view your work-in-process values by level, and

drill down to your accounting transactions

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
(T) Level

(N) CST View Transactions > WIP Value Summary (B) Find  >
Value Summary (T) Level

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Windows and Navigations >
Viewing WIP Value Summaries
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Viewing Job and Schedule Values OnlineViewing Job and Schedule Values Online

Use the WIP Transaction Distributions window,
Account Tab:
• To view your work-in-process values in summary

by account, and drill down to your accounting
transactions

(N) WIP Discrete > WIP Value Summary (B) Find > Distributions
(T) Account

(N) CST View Transactions > WIP Value Summary (B) Find  >
 Distributions (T) Account

Use the WIP Transaction Distributions window,
Account Tab:
• To view your work-in-process values in summary

by account, and drill down to your accounting
transactions

(N) WIP Discrete > WIP Value Summary (B) Find > Distributions
(T) Account

(N) CST View Transactions > WIP Value Summary (B) Find  >
 Distributions (T) Account

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Windows and Navigations >
Viewing WIP Value Summaries
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Viewing Job and Schedule Values OnlineViewing Job and Schedule Values Online

Use the WIP Transaction Distributions window,
Transaction Tab:
• To view your work-in-process accounting

transactions for both material and resource/
overhead transactions

(N) WIP Discrete > WIP Value Summary (B) Find > Distributions
(T) Transaction

(N) CST View Transactions > WIP Value Summary (B) Find  >
 Distributions (T) Transaction

Use the WIP Transaction Distributions window,
Transaction Tab:
• To view your work-in-process accounting

transactions for both material and resource/
overhead transactions

(N) WIP Discrete > WIP Value Summary (B) Find > Distributions
(T) Transaction

(N) CST View Transactions > WIP Value Summary (B) Find  >
 Distributions (T) Transaction

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Windows and Navigations >
Viewing WIP Value Summaries



Copyright © Oracle Corporation, 2000. All rights reserved.

Analyzing WIP Transactions
Chapter 2 - Page 13

Agenda

Copyright  Oracle Corporation, 2000. All rights reserved.
®

AgendaAgenda

• Overview of analyzing WIP transactions
• Viewing Job and Schedule Values Online
• Reporting and Analyzing WIP Values

– Wip Value Report
– Repetitive Value Report
– Expense Job Value Report
– Account Distribution Reports

•• Overview of analyzing WIP transactionsOverview of analyzing WIP transactions
•• Viewing Job and Schedule Values OnlineViewing Job and Schedule Values Online
• Reporting and Analyzing WIP Values

– Wip Value Report
– Repetitive Value Report
– Expense Job Value Report
– Account Distribution Reports
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Reporting and Analyzing WIP ValuesReporting and Analyzing WIP Values

ReportsReports VariancesVariances

Use work-in-process reports to analyze variances.Use work-in-process reports to analyze variances.
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WIP Value ReportWIP Value Report

Transaction Values
• The WIP Value Report shows work-in-process

transaction values for the chosen period or all
transaction values for jobs and schedules.

Transaction Values
• The WIP Value Report shows work-in-process

transaction values for the chosen period or all
transaction values for jobs and schedules.

WIP Value ReportWIP Value Report VariancesVariances

(Help) Oracle Manufacturing Applications > Oracle WIP  >
Reports and Processes > WIP Value Report
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Report Options
• Select the Period-to-Date option for expense jobs

and repetitive schedules, when you recognize
repetitive variances on all schedules at period end.
This choice reflects the activity for the period and
ties to the variance entries booked at period close.

• Select the Cumulative-to-Date option for discrete
jobs, asset nonstandard jobs, and repetitive
schedules, when you recognize repetitive
variances when schedules are completed or
canceled. This choice reflects all activity and
reports the net value of the job or schedule.

Report Options
• Select the Period-to-Date option for expense jobs

and repetitive schedules, when you recognize
repetitive variances on all schedules at period end.
This choice reflects the activity for the period and
ties to the variance entries booked at period close.

• Select the Cumulative-to-Date option for discrete
jobs, asset nonstandard jobs, and repetitive
schedules, when you recognize repetitive
variances when schedules are completed or
canceled. This choice reflects all activity and
reports the net value of the job or schedule.

Note
The report displays period-to-date and cumulative-to-date totals.
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WIP Value Report
When you recognize repetitive variances on all
schedules at period end, select the Period-to-Date
option for expense jobs and repetitive schedules.
When you recognize repetitive variances when
schedules are completed or canceled, select the
Cumulative-to-Date option for discrete jobs, asset
nonstandard jobs, and repetitive schedules.
1. True
2. False

WIP Value Report
When you recognize repetitive variances on all
schedules at period end, select the Period-to-Date
option for expense jobs and repetitive schedules.
When you recognize repetitive variances when
schedules are completed or canceled, select the
Cumulative-to-Date option for discrete jobs, asset
nonstandard jobs, and repetitive schedules.
1. True
2. False
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Review QuestionReview Question

WIP Value Report
When you recognize repetitive variances on all
schedules at period end, select the Period-to-Date
option for expense jobs and repetitive schedules.
When you recognize repetitive variances when
schedules are completed or canceled, select the
Cumulative-to-Date option for discrete jobs, asset
nonstandard jobs, and repetitive schedules.
1. True
2. False

WIP Value Report
When you recognize repetitive variances on all
schedules at period end, select the Period-to-Date
option for expense jobs and repetitive schedules.
When you recognize repetitive variances when
schedules are completed or canceled, select the
Cumulative-to-Date option for discrete jobs, asset
nonstandard jobs, and repetitive schedules.
1. True
2. False2. False
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Discrete Job Value ReportDiscrete Job Value Report

• The Discrete Job Value Report details the costs
incurred by, and relieved from, a job.

• The Discrete Job Value Report details the costs
incurred by, and relieved from, a job.

Discrete JobDiscrete Job
Value ReportValue Report

VariancesVariances
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Discrete Job Value ReportDiscrete Job Value Report

Job Costs
• Compare incurred costs to requirements based on

the planned start quantity or on the quantity
completed.

Planned Start Quantity
• This report option extends at standard the

required components, resources, and overheads
to build the planned start quantity. This value is
then compared to the costs incurred at the time
the report was submitted.

• Select this option to determine the remaining cost
to be incurred to complete a job.

Job Costs
• Compare incurred costs to requirements based on

the planned start quantity or on the quantity
completed.

Planned Start Quantity
• This report option extends at standard the

required components, resources, and overheads
to build the planned start quantity. This value is
then compared to the costs incurred at the time
the report was submitted.

• Select this option to determine the remaining cost
to be incurred to complete a job.
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Discrete Job Value ReportDiscrete Job Value Report

Completed Quantity
• This report option extends at standard the

required components, resources, and overheads
to build the quantity completed to inventory at the
time the report was submitted. This value is then
compared to the costs incurred at the time the
report was submitted.

• Select this option to analyze a job prior to closing
and recognizing the variances.

• Use this option only when you have completed
most or all of the assemblies.

Completed Quantity
• This report option extends at standard the

required components, resources, and overheads
to build the quantity completed to inventory at the
time the report was submitted. This value is then
compared to the costs incurred at the time the
report was submitted.

• Select this option to analyze a job prior to closing
and recognizing the variances.

• Use this option only when you have completed
most or all of the assemblies.
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Discrete Job Value ReportDiscrete Job Value Report

Variances
• Analyze your usage, efficiency, methods and

configuration variances.

Variances
• Analyze your usage, efficiency, methods and

configuration variances.

VariancesVariances
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Discrete Job Value ReportDiscrete Job Value Report

Usage and Configuration Variances
• Usage variances are calculated in the material

transaction section and in the cumulative-to-date
section of the report. Usage variances compare the
bill of material requirements at the time the job was
opened and the material actually issued to the job.

• Configuration variances can be calculated by
comparing the usage variance from the transaction
section to the usage variance in the cumulative-to-
date section. The difference is configuration variance.

Usage and Configuration Variances
• Usage variances are calculated in the material

transaction section and in the cumulative-to-date
section of the report. Usage variances compare the
bill of material requirements at the time the job was
opened and the material actually issued to the job.

• Configuration variances can be calculated by
comparing the usage variance from the transaction
section to the usage variance in the cumulative-to-
date section. The difference is configuration variance.
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Discrete Job Value ReportDiscrete Job Value Report

Usage and Configuration Variances
• The difference between the cumulative variance and

the usage variance is due to the standard bill
requirements and the WIP Bill requirements.  This
could be because the Bill has changed since the
standard was rolled up, or because the Job was
manually altered upon creation.

Usage and Configuration Variances
• The difference between the cumulative variance and

the usage variance is due to the standard bill
requirements and the WIP Bill requirements.  This
could be because the Bill has changed since the
standard was rolled up, or because the Job was
manually altered upon creation.
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Discrete Job Value ReportDiscrete Job Value Report

Efficiency and Methods Variances
• Efficiency variances are calculated in the resource

transaction section of the report and compare the
routing operations at the time the job was opened
and the resources and overheads earned.

• You also have an efficiency variance in the
cumulative-to-date section. This variance compares
the standard resource cost to the cost of the
resources charged to the job.

• Methods variances can be calculated by comparing
the efficiency variance from the transaction section
to the efficiency variance in the cumulative-to-date
section. The difference is your methods variance.

Efficiency and Methods Variances
• Efficiency variances are calculated in the resource

transaction section of the report and compare the
routing operations at the time the job was opened
and the resources and overheads earned.

• You also have an efficiency variance in the
cumulative-to-date section. This variance compares
the standard resource cost to the cost of the
resources charged to the job.

• Methods variances can be calculated by comparing
the efficiency variance from the transaction section
to the efficiency variance in the cumulative-to-date
section. The difference is your methods variance.
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Discrete Job Value ReportDiscrete Job Value Report

Efficiency and Methods Variances
• The difference between the cumulative variance and

the efficiency and methods variance is due to the
standard Routing requirements and the WIP Routing
requirements.  This could be because the Routing
has changed since the standard was rolled up, or
because the Job was manually altered upon creation.

Efficiency and Methods Variances
• The difference between the cumulative variance and

the efficiency and methods variance is due to the
standard Routing requirements and the WIP Routing
requirements.  This could be because the Routing
has changed since the standard was rolled up, or
because the Job was manually altered upon creation.
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Review QuestionReview Question

Discrete Job Value Report
Select the Planned Start Quantity option to determine
the remaining cost to be incurred to complete a job.
Select the Completed Quantity option to analyze a job
prior to closing a job when you have completed most
or all of the assemblies.
1. True
2. False

Discrete Job Value Report
Select the Planned Start Quantity option to determine
the remaining cost to be incurred to complete a job.
Select the Completed Quantity option to analyze a job
prior to closing a job when you have completed most
or all of the assemblies.
1. True
2. False
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Review QuestionReview Question

Discrete Job Value Report
Select the Planned Start Quantity option to determine
the remaining cost to be incurred to complete a job.
Select the Completed Quantity option to analyze a job
prior to closing a job when you have completed most
or all of the assemblies.
1. True
2. False

Discrete Job Value Report
Select the Planned Start Quantity option to determine
the remaining cost to be incurred to complete a job.
Select the Completed Quantity option to analyze a job
prior to closing a job when you have completed most
or all of the assemblies.
1. True
2. False2. False
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Repetitive Value ReportRepetitive Value Report

• The Repetitive Value Report details the costs
incurred by and relieved from your repetitive
schedules.

• The Repetitive Value Report details the costs
incurred by and relieved from your repetitive
schedules.

Repetitive ValueRepetitive Value
ReportReport

VariancesVariances



Copyright © Oracle Corporation, 2000. All rights reserved.

Analyzing WIP Transactions
Chapter 2 - Page 30

Repetitive Value Report

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Repetitive Value ReportRepetitive Value Report

Repetitive Assembly
• The Repetitive Value Report displays the sum of

all transactions associated with a repetitive
assembly on a line for the period you select.

Planned Start Quantity
• When you select this option, the report extends at

standard, the required components, resources,
and overheads to build the planned start quantity
for all schedules for an assembly on the line. This
value is then compared to the costs incurred at the
time the report was submitted.

• This option is useful for determining the remaining
cost to be incurred to complete all schedules for
this assembly on this line.

Repetitive Assembly
• The Repetitive Value Report displays the sum of

all transactions associated with a repetitive
assembly on a line for the period you select.

Planned Start Quantity
• When you select this option, the report extends at

standard, the required components, resources,
and overheads to build the planned start quantity
for all schedules for an assembly on the line. This
value is then compared to the costs incurred at the
time the report was submitted.

• This option is useful for determining the remaining
cost to be incurred to complete all schedules for
this assembly on this line.
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Repetitive Value ReportRepetitive Value Report

Completed Quantity
• When you select this option, the report extends at

standard the required components, resources, and
overheads to build the quantity completed at the
time the report was submitted. This value is then
compared to the costs incurred at the time the
report was submitted.

• Select this option to analyze a schedule or line prior
to period close or canceling your schedule
depending on your WIP parameters.

• Select this option to analyze variances when you
backflush your material requirements upon completion
or when you have completed most of the assemblies.

Completed Quantity
• When you select this option, the report extends at

standard the required components, resources, and
overheads to build the quantity completed at the
time the report was submitted. This value is then
compared to the costs incurred at the time the
report was submitted.

• Select this option to analyze a schedule or line prior
to period close or canceling your schedule
depending on your WIP parameters.

• Select this option to analyze variances when you
backflush your material requirements upon completion
or when you have completed most of the assemblies.
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Repetitive Value Report
The Planned Start Quantity is useful for determining
the remaining cost to be incurred to complete all
schedules for this assembly on this line.
Select the Completed Quantity option to analyze a
schedule or line prior to period close or canceling
your schedule, depending on your WIP parameters.
Select the Completed Quantity option to analyze
variances when you backflush your material
requirements upon completion or when you have
completed most of the assemblies.
1. True
2. False

Repetitive Value Report
The Planned Start Quantity is useful for determining
the remaining cost to be incurred to complete all
schedules for this assembly on this line.
Select the Completed Quantity option to analyze a
schedule or line prior to period close or canceling
your schedule, depending on your WIP parameters.
Select the Completed Quantity option to analyze
variances when you backflush your material
requirements upon completion or when you have
completed most of the assemblies.
1. True
2. False
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Repetitive Value Report
The Planned Start Quantity is useful for determining
the remaining cost to be incurred to complete all
schedules for this assembly on this line.
Select the Completed Quantity option to analyze a
schedule or line prior to period close or canceling
your schedule, depending on your WIP parameters.
Select the Completed Quantity option to analyze
variances when you backflush your material
requirements upon completion or when you have
completed most of the assemblies.
1. True
2. False

Repetitive Value Report
The Planned Start Quantity is useful for determining
the remaining cost to be incurred to complete all
schedules for this assembly on this line.
Select the Completed Quantity option to analyze a
schedule or line prior to period close or canceling
your schedule, depending on your WIP parameters.
Select the Completed Quantity option to analyze
variances when you backflush your material
requirements upon completion or when you have
completed most of the assemblies.
1. True
2. False2. False
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Expense Job Value ReportExpense Job Value Report

• The Expense Job Value Report details current
period and job to date expenses.

• The Expense Job Value Report details current
period and job to date expenses.

Expense JobExpense Job
ValueValue ReportReport
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Expense Job Value ReportExpense Job Value Report

Expenses
• The Expense Job Value Report reports

transactions at the standard cost in effect when
the transaction occurred.

Period Cost Tracking
• The Expense Job Value Report adds up current

period transaction values to report the expense
incurred for the period.

Cumulative Cost Tracking
• The Expense Job Value Report adds up all

transaction values to report the expense incurred
over the life of the job.

Expenses
• The Expense Job Value Report reports

transactions at the standard cost in effect when
the transaction occurred.

Period Cost Tracking
• The Expense Job Value Report adds up current

period transaction values to report the expense
incurred for the period.

Cumulative Cost Tracking
• The Expense Job Value Report adds up all

transaction values to report the expense incurred
over the life of the job.
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Account DistributionAccount Distribution
reportsreports

VariancesVariances

• The Account Distribution Reports show current
transactions.

• The Account Distribution  Reports show current
transactions.
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Material Account Distribution Detail Report
• Use the Material Account Distribution Detail

Report to analyze specific material transactions
that create variances.

WIP Account Distribution Report
• Use the WIP Account Distribution Report to

analyze specific resource, outside processing, or
overhead transactions that create variances.

Material Account Distribution Detail Report
• Use the Material Account Distribution Detail

Report to analyze specific material transactions
that create variances.

WIP Account Distribution Report
• Use the WIP Account Distribution Report to

analyze specific resource, outside processing, or
overhead transactions that create variances.
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Reporting WIP ValuesReporting WIP Values

Use the WIP Value Report to:
• Identify your significant variances with one line per

job or repetitive assembly
(N) CST Report  > Value

Use the Discrete, Repetitive, and Expense Value
Reports to:
• Analyze costs incurred, costs relieved, and variances
(N) CST Report  > Value

Use the Material Account Distribution Detail Report
and the WIP Account Distribution Report to:
• Analyze specific transactions
(N) CST Report  > Transactions

Use the WIP Value Report to:
• Identify your significant variances with one line per

job or repetitive assembly
(N) CST Report  > Value

Use the Discrete, Repetitive, and Expense Value
Reports to:
• Analyze costs incurred, costs relieved, and variances
(N) CST Report  > Value

Use the Material Account Distribution Detail Report
and the WIP Account Distribution Report to:
• Analyze specific transactions
(N) CST Report  > Transactions

(Help) Oracle Manufacturing Applications > Oracle WIP  >
Reports and Processes > WIP Value Report
(Help) Oracle Manufacturing Applications > Oracle WIP >
Reports and Processes >
Discrete Job Value Report - Standard Costing
(Help) Oracle Manufacturing Applications > Oracle WIP >
Reports and Processes > Repetitive Value Report
(Help) Oracle Manufacturing Applications > Oracle WIP >
Reports and Processes > Expense Job Value Report
(Help) Oracle Manufacturing Applications > Oracle Inventory >
Reports and Processes >
Material Account Distribution Detail Report
(Help) Oracle Manufacturing Applications > Oracle Inventory >
Reports and Processes > WIP Account Distribution Report
Note

On these reports, you see favorable variances as negative values.
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SummarySummary

• In this lesson, you should have learned how to:
– View WIP values online
– Report and analyze WIP values

• In this lesson, you should have learned how to:
– View WIP values online
– Report and analyze WIP values

Inquiries and analysisInquiries and analysis ReportsReports
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Practice 2 OverviewPractice 2 Overview

This practice covers the following topics:
• Reviewing WIP costing analysis
• Reviewing the WIP Value Summary using

examples
• Performing and analyzing WIP transactions in a

standard costing environment

This practice covers the following topics:
• Reviewing WIP costing analysis
• Reviewing the WIP Value Summary using

examples
• Performing and analyzing WIP transactions in a

standard costing environment
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Practice 2-1: Reviewing WIP Costing
Analysis

Practice 2-1: Reviewing WIP Costing
Analysis

In this practice, you provide short answers to questions:
1.  Which report do you run to identify your significant

variances?
2.  Why would you select the Planned Start Quantity

option for the Discrete Job Value Report?
3.  Why would you select the Completed Quantity

option for the Discrete Job Value Report?

In this practice, you provide short answers to questions:
1.  Which report do you run to identify your significant

variances?
2.  Why would you select the Planned Start Quantity

option for the Discrete Job Value Report?
3.  Why would you select the Completed Quantity

option for the Discrete Job Value Report?
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Practice 2-1: Reviewing WIP Costing
Analysis Solution

Practice 2-1: Reviewing WIP Costing
Analysis Solution

Reviewing WIP Costing Analysis
1.  Which report do you run to identify your

significant variances?
Use the WIP Value report to identify your
significant variances.

2.  Why would you select the Planned Start Quantity
option for the Discrete Job Value Report?
Select the Planned Start Quantity option when you
want to determine the remaining costs to be
incurred to complete a job. You run it at the
beginning of a job.

Reviewing WIP Costing Analysis
1.  Which report do you run to identify your

significant variances?
Use the WIP Value report to identify your
significant variances.

2.  Why would you select the Planned Start Quantity
option for the Discrete Job Value Report?
Select the Planned Start Quantity option when you
want to determine the remaining costs to be
incurred to complete a job. You run it at the
beginning of a job.
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Practice 2-1: Reviewing WIP Costing
Analysis Solution

Practice 2-1: Reviewing WIP Costing
Analysis Solution

Reviewing WIP Costing Analysis
3.  Why would you select the Completed Quantity

option for the Discrete Job Value Report?
Select the Completed Quantity option when you
want to analyze the job prior to job close. This
report is useful in determining the causes of
variances in your discrete jobs.

Reviewing WIP Costing Analysis
3.  Why would you select the Completed Quantity

option for the Discrete Job Value Report?
Select the Completed Quantity option when you
want to analyze the job prior to job close. This
report is useful in determining the causes of
variances in your discrete jobs.
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Practice 2-2: Reviewing the WIP Value
Summary using Examples

Practice 2-2: Reviewing the WIP Value
Summary using Examples

In this practice, examples are used for you to review
the charges that appear in the WIP Value Summary
for the following:
• Material
• Material overhead
• Resource
• Outside processing
• Overhead

In this practice, examples are used for you to review
the charges that appear in the WIP Value Summary
for the following:
• Material
• Material overhead
• Resource
• Outside processing
• Overhead

Help: Oracle Manufacturing Applications  >
Oracle Work in Process > Windows and Navigations >
Viewing WIP Value Summaries
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Practice 2-2: Reviewing the WIP Value
Summary, Components Issued to WIP
Practice 2-2: Reviewing the WIP Value
Summary, Components Issued to WIP

Example
• You are a stockroom clerk for Vision. In your job,

you stage workorders, issuing push components
to jobs.  You also replace defective components
with substitute components.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following WIP material transactions:
– Issues of all push components
– Returns of specific components
– Issues of specific components

Example
• You are a stockroom clerk for Vision. In your job,

you stage workorders, issuing push components
to jobs.  You also replace defective components
with substitute components.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following WIP material transactions:
– Issues of all push components
– Returns of specific components
– Issues of specific components
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Practice 2-2: Reviewing the WIP Value
Summary, Components Issued to WIP
Practice 2-2: Reviewing the WIP Value
Summary, Components Issued to WIP

1.  WIP material transaction (issue all material)
Push all components into the job.
10 units at standard cost of $250 = $2,500.

2.  WIP material transaction (return specific component)
Return two defective units of component 2 to inventory.
2 units at standard cost of $33 = $66.

3.  WIP material transaction (issue specific component)
Replace defective components with substitute items.
2 units at standard cost of $40 = $80.

1.  WIP material transaction (issue all material)
Push all components into the job.
10 units at standard cost of $250 = $2,500.

2.  WIP material transaction (return specific component)
Return two defective units of component 2 to inventory.
2 units at standard cost of $33 = $66.

3.  WIP material transaction (issue specific component)
Replace defective components with substitute items.
2 units at standard cost of $40 = $80.
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Practice 2-2: Reviewing the WIP Value
Summary, Components Issued to WIP
Practice 2-2: Reviewing the WIP Value
Summary, Components Issued to WIP

The following table is a summary of all transactions
to this point.
The following table is a summary of all transactions
to this point.

Work in Process Value
Cost Incurred Cost Relieved Balance

Cost Element
This
Level

Previous
Level

This
Level

Previous
Level

This
Level

Previous
Level

Material 2,514 2,514
Material OH
Resource
OSP
Overhead
Total 2,514 2,514
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Practice 2-2: Reviewing the WIP Value
Summary, Resource Charges to WIP

Example
• You are an assembler on a subassembly

production line for Vision. In your job, you build
assemblies on workorders, charging resources to
jobs.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor resource transactions:
– Resource transaction without rate variance
– Resource transaction reversal
– Resource transaction with rate variance

Example
• You are an assembler on a subassembly

production line for Vision. In your job, you build
assemblies on workorders, charging resources to
jobs.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor resource transactions:
– Resource transaction without rate variance
– Resource transaction reversal
– Resource transaction with rate variance
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Practice 2-2: Reviewing the WIP Value
Summary, Resource Charges to WIP

4.  Shop floor transaction (resource without rate variance)
     Charge resource RS1 at actual for operation 10.
     11 hours at $50 = $550.
5.  Shop floor transaction (reverse resource charge)

Reverse overcharge.
1 hour at $50 = $50.

6.  Shop floor transaction (resource with rate variance)
Charge resource RS2 at standard for operation 20.
5 units at $25 = $125.

4.  Shop floor transaction (resource without rate variance)
     Charge resource RS1 at actual for operation 10.
     11 hours at $50 = $550.
5.  Shop floor transaction (reverse resource charge)

Reverse overcharge.
1 hour at $50 = $50.

6.  Shop floor transaction (resource with rate variance)
Charge resource RS2 at standard for operation 20.
5 units at $25 = $125.
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Practice 2-2: Reviewing the WIP Value
Summary, Resource Charges to WIP

Practice 2-2: Reviewing the WIP Value
Summary, Resource Charges to WIP

The following table is a summary of all transactions
to this point.
The following table is a summary of all transactions
to this point.

Work in Process Value
Cost Incurred Cost Relieved Balance

Cost Element
This
Level

Previous
Level

This
Level

Previous
Level

This
Level

Previous
Level

Material 2,514 2,514
Material OH
Resource 625 625
OSP
Overhead
Total    625 2,514    625 2,514
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Practice 2-2: Reviewing the WIP Value
Summary, Overhead Charges to WIPOverhead Charges to WIP

Example
• You are an assembler on a subassembly

production line for Vision. In your job, you move
assemblies on workorders. When you move
assemblies, the system charges overhead costs
automatically based on resource units or value or
by item or lot.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor overhead transactions:
– Resource-based overhead transaction
– Resource-based overhead transaction reversal
– Item-based overhead transaction

Example
• You are an assembler on a subassembly

production line for Vision. In your job, you move
assemblies on workorders. When you move
assemblies, the system charges overhead costs
automatically based on resource units or value or
by item or lot.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor overhead transactions:
– Resource-based overhead transaction
– Resource-based overhead transaction reversal
– Item-based overhead transaction
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Practice 2-2: Reviewing the WIP Value
Summary, Overhead Charges to WIPOverhead Charges to WIP

7.   Shop floor transaction (resource-based overhead)
 Charge 250% on the resource charged in step 4.
 $550 * 250% = $1,375.

8.   Shop floor transaction (reverse resource-based
      overhead)

 Reverse overhead for resource reversed in step 5.
 $50 * 250% = $125.

9.   Shop floor transaction (item-based overhead)
 Move through operation 20; charge item-based

      overhead.
 10 units at $20 = $200.

7.   Shop floor transaction (resource-based overhead)
 Charge 250% on the resource charged in step 4.
 $550 * 250% = $1,375.

8.   Shop floor transaction (reverse resource-based
      overhead)

 Reverse overhead for resource reversed in step 5.
 $50 * 250% = $125.

9.   Shop floor transaction (item-based overhead)
 Move through operation 20; charge item-based

      overhead.
 10 units at $20 = $200.
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Practice 2-2: Reviewing the WIP Value
Summary, Overhead Charges to WIPOverhead Charges to WIP

The following table is a summary of all transactions
to this point.
The following table is a summary of all transactions
to this point.

Work in Process Value
Cost Incurred Cost Relieved Balance

Cost Element
This
Level

Previous
Level

This
Level

Previous
Level

This
Level

Previous
Level

Material 2,514 2,514
Material OH
Resource 625 625
OSP
Overhead 1,450 1,450
Total  2075 2,514  2075 2,514
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Practice 2-2: Reviewing the WIP Value
Summary, Outside Processing to WIP

Example
• You are a shop floor production worker for Vision.

In your job, you receive assemblies on workorders
from outside suppliers and subcontractors,
charging outside processing resources to jobs.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor outside processing (OSP)
resource transactions:
– OSP resource transaction without rate variance
– OSP resource transaction reversal
– Resource overhead on OSP resource

Example
• You are a shop floor production worker for Vision.

In your job, you receive assemblies on workorders
from outside suppliers and subcontractors,
charging outside processing resources to jobs.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor outside processing (OSP)
resource transactions:
– OSP resource transaction without rate variance
– OSP resource transaction reversal
– Resource overhead on OSP resource
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Practice 2-2: Reviewing the WIP Value
Summary, Outside Processing to WIP

10. Shop floor transaction
(OSP resource without rate variance)
Charge OSP OS1 at actual for operation 30.
Receive 11 units at $25 = $275.

11. Shop floor transaction
(reverse OSP charge)
Reverse overcharge.
1 unit at $25 = $25.

12. Shop floor transaction
(resource overhead on OSP resource)
Charge overhead at 1 unit at $20.

10. Shop floor transaction
(OSP resource without rate variance)
Charge OSP OS1 at actual for operation 30.
Receive 11 units at $25 = $275.

11. Shop floor transaction
(reverse OSP charge)
Reverse overcharge.
1 unit at $25 = $25.

12. Shop floor transaction
(resource overhead on OSP resource)
Charge overhead at 1 unit at $20.
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Practice 2-2: Reviewing the WIP Value
Summary, Outside Processing to WIP

The following table is a summary of all transactions
to this point.
The following table is a summary of all transactions
to this point.

Work in Process Value
Cost Incurred Cost Relieved Balance

Cost Element
This
Level

Previous
Level

This
Level

Previous
Level

This
Level

Previous
Level

Material 2,514 2,514
Material OH
Resource 625 625
OSP 250 250
Overhead 1,470 1,470
Total 2,345 2,514 2,345 2,514
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Practice 2-2: Reviewing the WIP Value
Summary, Completion Transactions

Viewing Charges Online
• Use the WIP Value Summary window to view relief

charges from WIP completion transactions from a
specific job or schedule.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Viewing Charges Online
• Use the WIP Value Summary window to view relief

charges from WIP completion transactions from a
specific job or schedule.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary

Help: Oracle Manufacturing Applications >
Oracle Work in Process > Windows and Navigations >
Viewing WIP Value Summaries
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Practice 2-2: Reviewing the WIP Value
Summary, Completions and Scrap

Example
• You are an assembler and a tester on a

subassembly production line for Vision. In your job,
you scrap defective assemblies and complete good
assemblies on workorders.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor scrap transactions and WIP
completion transaction:
– Scrap transaction
– Scrap transaction reversal
– WIP completion transaction

Example
• You are an assembler and a tester on a

subassembly production line for Vision. In your job,
you scrap defective assemblies and complete good
assemblies on workorders.

• The controller has asked your cost accountant for
an analysis of the accounting flows for the
following shop floor scrap transactions and WIP
completion transaction:
– Scrap transaction
– Scrap transaction reversal
– WIP completion transaction



Copyright © Oracle Corporation, 2000. All rights reserved.

Analyzing WIP Transactions
Chapter 2 - Page 59

Practice 2-2: Reviewing the WIP Value Summary,
Completions and Scrap

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice 2-2: Reviewing the WIP Value
Summary, Completions and Scrap

Practice 2-2: Reviewing the WIP Value
Summary, Completions and Scrap

13. Shop floor transaction
 Scrap two assemblies at operation 40.
 2 units at $467 = $934.

14. Shop floor transaction
 Return repaired unit from scrap.
 1 unit at $467.

15. WIP completion transaction
 Complete nine assemblies from WIP to inventory.
 9 units at $467 = $4203 + 9 units at $20 for material

      overhead.

13. Shop floor transaction
 Scrap two assemblies at operation 40.
 2 units at $467 = $934.

14. Shop floor transaction
 Return repaired unit from scrap.
 1 unit at $467.

15. WIP completion transaction
 Complete nine assemblies from WIP to inventory.
 9 units at $467 = $4203 + 9 units at $20 for material

      overhead.
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Practice 2-2: Reviewing the WIP Value
Summary, Completions and Scrap

The following table is a summary of all transactions
to this point.
The following table is a summary of all transactions
to this point.

Work in Process Value
Cost Incurred Cost Relieved Balance

Cost Element
This
Level

Previous
Level

This
Level

Previous
Level

This
Level

Previous
Level

Material 2,514      14
Material OH
Resource 625 500 125
OSP 250   50
Overhead 1,470    445
Total 2,345 2,514    620     14

2,500

 1025
200

 1725  2500
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Practice 2-3: Performing and Analyzing
WIP Transactions in Standard Costing

In this practice, you are a cost accountant and you
define and process a discrete job from release to
completion for assembly AS62445 in the Vision
Database.
• After each WIP transaction that you perform, you

review the job value using the WIP Value Summary
window. This will help you to analyze the impact of
each transaction.

• After the discrete job is closed, you run various
reports to analyze variances.

In this practice, you are a cost accountant and you
define and process a discrete job from release to
completion for assembly AS62445 in the Vision
Database.
• After each WIP transaction that you perform, you

review the job value using the WIP Value Summary
window. This will help you to analyze the impact of
each transaction.

• After the discrete job is closed, you run various
reports to analyze variances.

Instructions
1. Check the status of the Material Cost transaction processor. If this processor
is not running or is running at an interval greater than 10 minutes, inform the
instructor.
2. Define a released, discrete job for AS62445. Set the quantity equal to 10 and
the due date equal to Friday of this week.
Record the job number that the system assigns here:_______
3.  Issue to the job any push material needed at the start of the job and 5
addtional pieces of CM22680.
4. Move the job through its routing. Execute a scrap transaction for a quantity of
2 and verify that the assembly pull components are charged to the job.
5. Receive a partial quantity into the finished goods (FGI) subinventory.
6. Receive the balance of the job into the FGI subinventory.
7. Close the job. Be careful to close only your job, to avoid interfering with
other students’ jobs.
8. Review material transaction distributions and job costs in the Material
Transaction Distributions window and the WIP Value Summary window. View
the accounting distributions created by the transactions and item costs.
9. If time permits, run the Discrete Job Value Report for your job, and review
the results online. 
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Practice 2-3: Reviewing the Cost
Structure for AS62445 in Vision

Subassembly=Subassembly=
SB22680SB22680

 Final assembly=AS62445 Final assembly=AS62445

Phantom assembly=Phantom assembly=
PH22681PH22681

PurchasedPurchased
item=CM22684item=CM22684

Purchased item=Purchased item=
CM22682CM22682

PurchasedPurchased
item=CM22683item=CM22683

PurchasedPurchased
item=CM22680item=CM22680



Copyright © Oracle Corporation, 2000. All rights reserved.

Analyzing WIP Transactions
Chapter 2 - Page 63

Practice 2-3: Reviewing the Cost Structure for AS62445
in Vision

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Practice 2-3: Reviewing the Cost
Structure for AS62445 in Vision

Practice 2-3: Reviewing the Cost
Structure for AS62445 in Vision

Vision Database Data
• Data was populated in the Vision database to

facilitate practices and demonstrations. In this
course, we will demonstrate functionality using
SB22680, performing transactions and seeing their
financial impact.

• For standard costing, we use the M1 organization,
verifying that costs exist in the Frozen cost type.

• In M1, you do not have to worry about having
onhand balances because the organization allows
negative balances.

Vision Database Data
• Data was populated in the Vision database to

facilitate practices and demonstrations. In this
course, we will demonstrate functionality using
SB2268022680, performing transactions and seeing their
financial impact.

• For standard costing, we use the M1 organization,
verifying that costs exist in the Frozen cost type.

• In M1, you do not have to worry about having
onhand balances because the organization allows
negative balances.
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Practice 2-3: Reviewing the Cost
Structure for AS62445 in Vision

Assumptions
• Supply types for components:

CM22680, push; CM22682, operation pull;
CM22683, assembly pull; SB22680, operation pull.

• All resources except lead prep were person type
resources having the following: UOM=HR, charge
type = WIP move, basis = item and overhead =
benefits. The only difference with lead prep was
that it was a machine type resource.

• Existing departments were used for assembly,
test, pack, and upgrade.

Assumptions
• Supply types for components:

CM22680, push; CM22682, operation pull;
CM22683, assembly pull; SB22680, operation pull.

• All resources except lead prep were person type
resources having the following: UOM=HR, charge
type = WIP move, basis = item and overhead =
benefits. The only difference with lead prep was
that it was a machine type resource.

• Existing departments were used for assembly,
test, pack, and upgrade.
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Practice 2-3: Reviewing the Cost
Structure for AS62445 in Vision

Assumptions
• Routings were created with operation sequences

set to backflush, usage set at 10 units per hour,
and completion and supply subinventories from
RIP.
– Existing overheads were used for material

handling, equipment/tool, preventative
maintenance, benefits, and manufacturing
management.

• Ensure that the interface managers are up and
running.

Assumptions
• Routings were created with operation sequences

set to backflush, usage set at 10 units per hour,
and completion and supply subinventories from
RIP.
– Existing overheads were used for material

handling, equipment/tool, preventative
maintenance, benefits, and manufacturing
management.

• Ensure that the interface managers are up and
running.
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Practice 1-2: Performing and Analyzing
Inventory Transactions

In this practice, you will be doing the following in the
screens that follow:
1.  Verify that the transaction processor is running.
2.  Create a discrete job.
3.  Check material requirements.
4.  Review job costs using the Discrete Job Value Report.
5.  Issue push material and issue additional push material.
6.  Verify that push material was recorded and valued.
7.  Perform move transactions.
8.  Perform completion transactions.
9.  Verify WIP charges in the WIP Value Summary.
10.Close your job.
11.Run the Discrete Job Value Report.
12.Run the WIP Value Report.

In this practice, you will be doing the following in the
screens that follow:
1.  Verify that the transaction processor is running.
2.  Create a discrete job.
3.  Check material requirements.
4.  Review job costs using the Discrete Job Value Report.
5.  Issue push material and issue additional push material.
6.  Verify that push material was recorded and valued.
7.  Perform move transactions.
8.  Perform completion transactions.
9.  Verify WIP charges in the WIP Value Summary.
10.Close your job.
11.Run the Discrete Job Value Report.
12.Run the WIP Value Report.
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Guided Practice 2-3: Checking the
Inferface Managers

Guided Practice 2-3: Checking the
Inferface Managers

1.  Navigate to the Interface Managers window to
check the status of the Cost Manager. If this
manager is not running or is running at an interval
greater than 10 minutes, inform the instructor.

(N) INV Setup > Transactions > Interface Managers

1.  Navigate to the Interface Managers window to
check the status of the Cost Manager. If this
manager is not running or is running at an interval
greater than 10 minutes, inform the instructor.

(N) INV Setup > Transactions > Interface Managers
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Jobs

Guided Practice 2-3: Defining Discrete
Jobs

1.  Navigate to the Discrete Jobs window to define a
released, discrete job for SB22680, as follows:

(N) WIP Discrete > Discrete Jobs (B) New
2.  Job: xx-job01, where xx are your initials
3.  Type: Standard
4.  Assembly: SB22680
5.  Class: Discrete
6.  Status: Released
7.  Start quantity: 10
8.  MRP Net: 10
9.  Start date: Today’s date
10.Save and record the job number that the system
assigns here:_______

1.  Navigate to the Discrete Jobs window to define a
released, discrete job for SB22680, as follows:

(N) WIP Discrete > Discrete Jobs (B) New
2.  Job: xx-job01, where xx are your initials
3.  Type: Standard
4.  Assembly: SB22680
5.  Class: Discrete
6.  Status: Released
7.  Start quantity: 10
8.  MRP Net: 10
9.  Start date: Today’s date
10.Save and record the job number that the system
assigns here:_______
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Requirements

Guided Practice 2-3: Checking Material
Requirements

1.  Navigate to the Material Requirements window to
check your material requirements for any push
material needed at the start of the job.

(N) WIP Discrete > Discrete Jobs (F) Enter job number (B)
Components > Supply

• At this point, you haven’t issued any material to
your job.

1.  Navigate to the Material Requirements window to
check your material requirements for any push
material needed at the start of the job.

(N) WIP Discrete > Discrete Jobs (F) Enter job number (B)
Components > Supply

• At this point, you haven’t issued any material to
your job.
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Costs Using Discrete Job Value Report

Guided Practice 2-3: Reviewing Job
Costs Using Discrete Job Value Report

Run the Discrete Job Value Report - Standard
Costing to determine the remaining cost to be
incurred to complete your job.
1.  Navigate to the Request Value Reports window
(N) CST Report > Value
2. The Submit a new Request window opens
3. Check Select Single Request and choose OK
4. Name: Discrete Job Value Report - Standard
Costing
5. Choose: OK
(continued on next page)

Run the Discrete Job Value Report - Standard
Costing to determine the remaining cost to be
incurred to complete your job.
1.  Navigate to the Request Value Reports window
(N) CST Report > Value
2. The Submit a new Request window opens
3. Check Select Single Request and choose OK
4. Name: Discrete Job Value Report - Standard
Costing
5. Choose: OK
(continued on next page)
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Costs Using Discrete Job Value Report

Guided Practice 2-3: Reviewing Job
Costs Using Discrete Job Value Report

6. Enter parameters:
7. Sort By: Job
8. Report Type: Detail with requirements based on
Planned Start Quantity
9. Class Type: Standard Discrete
10. Job From: Your job
11. Job To: Your job
12. Exchange Rate: 1
13. Select OK and choose submit
14. Record your request number here_________.

6. Enter parameters:
7. Sort By: Job
8. Report Type: Detail with requirements based on
Planned Start Quantity
9. Class Type: Standard Discrete
10. Job From: Your job
11. Job To: Your job
12. Exchange Rate: 1
13. Select OK and choose submit
14. Record your request number here_________.
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Online

Guided Practice 2-3: Viewing the Results
Online

1. Navigate to the Requests window to check that
your report request has completed and to view output
online.
(N) CST Setup > Requests (B) View Output

2.  Check Specific Request
3.  Request ID: Enter your request number
4.  Choose: Find
5.  Choose: View Output

1. Navigate to the Requests window to check that
your report request has completed and to view output
online.
(N) CST Setup > Requests (B) View Output

2.  Check Specific Request
3.  Request ID: Enter your request number
4.  Choose: Find
5.  Choose: View Output
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Material

Guided Practice 2-3: Issuing Push
Material

1.  Navigate to the Material Transactions window to
issue your push material needed at the start of the
job.

(N) WIP Material Transactions > WIP Material Transactions
2.  Job: xx-job01, where xx are your initials
3.  Date: Today’s date
4.  Type: WIP component issue
5.  Subinventory: Stores
6.  Choose: Continue
7.  Action: Check that your push components appear
8.  Choose: Done

1.  Navigate to the Material Transactions window to
issue your push material needed at the start of the
job.

(N) WIP Material Transactions > WIP Material Transactions
2.  Job: xx-job01, where xx are your initials
3.  Date: Today’s date
4.  Type: WIP component issue
5.  Subinventory: Stores
6.  Choose: Continue
7.  Action: Check that your push components appear
8.  Choose: Done
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Guided Practice 2-3: Valuing Push
Material

1.  Navigate to the Material Transaction Distributions
window to verify that your push material needed at
the start of the job was recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions
(T) Accounts > Type

2.  Transaction Dates: Today’s date
3.  Item: CM22680
4.  Choose: Find
• Observe that WIP Valuation material and material

overhead accounts were charged while only the
inventory material valuation was credited.

1.  Navigate to the Material Transaction Distributions
window to verify that your push material needed at
the start of the job was recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions
(T) Accounts > Type

2.  Transaction Dates: Today’s date
3.  Item: CM22680
4.  Choose: Find
• Observe that WIP Valuation material and material

overhead accounts were charged while only the
inventory material valuation was credited.
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Guided Practice 2-3: Valuing Your Job
using the WIP Value Summary

1.  Navigate to the WIP Value Summary window to
verify that your push material needed at the start
of the job was recorded and valued.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Choose: Value Summary
4.  Select Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of the push

components in your job
7.  Select Cost Element: Material Overhead
8.  Choose: Distributions
9.  Action: Verify the distributions of the push

components in your job

1.  Navigate to the WIP Value Summary window to
verify that your push material needed at the start
of the job was recorded and valued.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Choose: Value Summary
4.  Select Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of the push

components in your job
7.  Select Cost Element: Material Overhead
8.  Choose: Distributions
9.  Action: Verify the distributions of the push

components in your job
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Guided Practice 2-3: Issuing Push
Material

1.  Navigate to the Material Transactions window to
issue five additional pieces of CM22680 to the job.

(N) WIP Material Transactions > WIP Material Transactions
2.  Job: xx-job01
3.  Date: Today’s date
4.  Type: WIP component issue
5.  Subinventory: Stores
6.  Choose: Specific component
7.  Choose: Continue
8.  Item: CM22680
9.  Subinventory: Stores
10.Operation: 10
11.Quantity: 5
11.Choose: Done

1.  Navigate to the Material Transactions window to
issue five additional pieces of CM22680 to the job.

(N) WIP Material Transactions > WIP Material Transactions
2.  Job: xx-job01
3.  Date: Today’s date
4.  Type: WIP component issue
5.  Subinventory: Stores
6.  Choose: Specific component
7.  Choose: Continue
8.  Item: CM22680
9.  Subinventory: Stores
10.Operation: 10
11.Quantity: 5
11.Choose: Done
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Guided Practice 2-3: Valuing Push
Material

1.  Navigate to the Material Transaction Distributions
window to verify that your additional five pieces of
CM22680 were recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions
(T) Accounts > Type

2.  Transaction Dates: Today’s date
3.  Item: CM22680
4.  Choose: Find
5.  Select the transaction with the primary quantity of -5
6.  Choose distributions
• Observe that WIP Valuation material and material

overhead accounts were charged while only the
inventory material valuation was credited.

1.  Navigate to the Material Transaction Distributions
window to verify that your additional five pieces of
CM22680 were recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions
(T) Accounts > Type

2.  Transaction Dates: Today’s date
3.  Item: CM22680
4.  Choose: Find
5.  Select the transaction with the primary quantity of -5
6.  Choose distributions
• Observe that WIP Valuation material and material

overhead accounts were charged while only the
inventory material valuation was credited.
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Guided Practice 2-3: Reviewing Job
Costs Using the WIP Value Summary

1.  Navigate to the WIP Value Summary window to
verify that your additional five pieces of CM22680
were recorded and valued.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Choose: Value Summary
4.  Select Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of the additional

push components in your job
7.  Select Cost Element: Material Overhead
8.  Choose: Distributions
9.  Action: Verify the distributions of the additional

push components in your job

1.  Navigate to the WIP Value Summary window to
verify that your additional five pieces of CM22680
were recorded and valued.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Choose: Value Summary
4.  Select Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of the additional

push components in your job
7.  Select Cost Element: Material Overhead
8.  Choose: Distributions
9.  Action: Verify the distributions of the additional

push components in your job
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Guided Practice 2-3: Performing Move
Transactions

1.  Navigate to the WIP Value Summary window  to
move all of the assemblies From Op Seq: 10, Step:
Queue to Op Seq: 20, Step: To Move.

(N) WIP Move Transactions > Move Transactions
2.  Job: xx-job01
3.  From Op Seq: 10, Step Queue
4.  Transaction Type Move: Check Move
5. To: Seq 20, Step: To move
6.  Quantity: 10
7.  Date:Today’s date
8.  Quantity: 10
9.  Save

1.  Navigate to the WIP Value Summary window  to
move all of the assemblies From Op Seq: 10, Step:
Queue to Op Seq: 20, Step: To Move.

(N) WIP Move Transactions > Move Transactions
2.  Job: xx-job01
3.  From Op Seq: 10, Step Queue
4.  Transaction Type Move: Check Move
5. To: Seq 20, Step: To move
6.  Quantity: 10
7.  Date:Today’s date
8.  Quantity: 10
9.  Save
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Guided Practice 2-3: Performing
Completions

1.  Perform a completion for all ten of SB22680.
(N) WIP Material Transactions > Completion Transactions
2.  Job: xx-job01
3.  Type: WIP assembly completion
4.  Date: Today’s date
5.  Job Quantity: 10
6.  Job Complete: 0
7.  Available to Complete: 10
8.  Choose: Continue
9.  Subinventory: RIP
11.Quantity: 10
12.Choose: Done

1.  Perform a completion for all ten of SB22680.
(N) WIP Material Transactions > Completion Transactions
2.  Job: xx-job01
3.  Type: WIP assembly completion
4.  Date: Today’s date
5.  Job Quantity: 10
6.  Job Complete: 0
7.  Available to Complete: 10
8.  Choose: Continue
9.  Subinventory: RIP
11.Quantity: 10
12.Choose: Done
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1.  Navigate to the Material Transaction Distributions
window to verify that your ten completions were
recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions
(T) Reason, Reference

2.  Item: SB22680
3.  Choose: Find
4.  Costed: Yes

1.  Navigate to the Material Transaction Distributions
window to verify that your ten completions were
recorded and valued.

(N) INV Transactions > Material Transactions (B) Distributions
(T) Reason, Reference

2.  Item: SB22680
3.  Choose: Find
4.  Costed: Yes
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Guided Practice 2-3: Valuing Your Job
using the WIP Value Summary

1.  Navigate to the WIP Value Summary window to
verify the value of your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your push components,

your additional components, your moves and your
completions in your job

4.  Choose: Value Summary
5.  Choose Cost Element: Material
6.  Choose: Distributions
7.  Action: Verify the distributions of your job.
8.  Choose Cost Element: Resource
9.  Choose: Distributions
10. Action: Verify the distributions of your job.

1.  Navigate to the WIP Value Summary window to
verify the value of your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your push components,

your additional components, your moves and your
completions in your job

4.  Choose: Value Summary
5.  Choose Cost Element: Material
6.  Choose: Distributions
7.  Action: Verify the distributions of your job.
8.  Choose Cost Element: Resource
9.  Choose: Distributions
10. Action: Verify the distributions of your job.
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Guided Practice 2-3: Reviewing Job
Costs Using the Discrete Job Value

ReportRun the Discrete Job Value Report - Standard
Costing to analyze your job prior to closing and
recognizing variances.
1.  Navigate to the Request Value Reports window
(N) CST Report > Value
2. The Submit a new Request window opens
3. Check Select Single Request and choose OK
4. Name: Discrete Job Value Report - Standard
Costing
5. Choose: OK
(continued on next page)

Run the Discrete Job Value Report - Standard
Costing to analyze your job prior to closing and
recognizing variances.
1.  Navigate to the Request Value Reports window
(N) CST Report > Value
2. The Submit a new Request window opens
3. Check Select Single Request and choose OK
4. Name: Discrete Job Value Report - Standard
Costing
5. Choose: OK
(continued on next page)
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Guided Practice 2-3: Reviewing Job
Costs Using the Discrete Job Value

Report6. Enter parameters:
7. Sort By: Job
8. Report Type: Detail with requirements based on
Actual Quantity Completed
9. Class Type: Standard Discrete
10. Job From: Your job
11. Job To: Your job
12. Exchange Rate: 1
13. Select OK and choose submit
14. Record your request number here_________.

6. Enter parameters:
7. Sort By: Job
8. Report Type: Detail with requirements based on
Actual Quantity Completed
9. Class Type: Standard Discrete
10. Job From: Your job
11. Job To: Your job
12. Exchange Rate: 1
13. Select OK and choose submit
14. Record your request number here_________.



Copyright © Oracle Corporation, 2000. All rights reserved.

Analyzing WIP Transactions
Chapter 2 - Page 85

Guided Practice 2-3: Viewing the Results Online

Copyright  Oracle Corporation, 2000. All rights reserved.
®

Guided Practice 2-3: Viewing the Results
Online

Guided Practice 2-3: Viewing the Results
Online

1. Navigate to the Requests window to check that
your report request has completed and to view output
online.
(N) CST Setup > Requests (B) View Output

2.  Check Specific Request
3.  Request ID: Enter your request number
4.  Choose: Find
5.  Choose: View Output

1. Navigate to the Requests window to check that
your report request has completed and to view output
online.
(N) CST Setup > Requests (B) View Output

2.  Check Specific Request
3.  Request ID: Enter your request number
4.  Choose: Find
5.  Choose: View Output
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Guided Practice 2-3: Closing Discrete
Jobs

1.  Navigate to the Close Discrete Jobs window to
close only your job.

(N) WIP Discrete > Close Discrete Jobs > Close Discrete Job
(SRS)

2.  Request Name: Close Discrete Jobs
3.  Parameters window
4.  Class Type:  Standard discrete
5.  From Job: Your job number
6.  To Job: Your job number
7.  Report Type: Summary
7.  OK
8.  Choose: Submit
9.  Record your request number here:__________

1.  Navigate to the Close Discrete Jobs window to
close only your job.

(N) WIP Discrete > Close Discrete Jobs > Close Discrete Job
(SRS)

2.  Request Name: Close Discrete Jobs
3.  Parameters window
4.  Class Type:  Standard discrete
5.  From Job: Your job number
6.  To Job: Your job number
7.  Report Type: Summary
7.  OK
8.  Choose: Submit
9.  Record your request number here:__________
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Guided Practice 2-3: Reviewing RequestsGuided Practice 2-3: Reviewing Requests

1.  Navigate to the Requests window to check to make
sure that your close request has completed.

CST Setup > Requests (T) Query your request number (B) View
Output

1.  Navigate to the Requests window to check to make
sure that your close request has completed.

CST Setup > Requests (T) Query your request number (B) View
Output
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Guided Practice 2-3: Valuing Your Job
using the WIP Value Summary

1.  Navigate to the WIP Value Summary window to
verify the value of your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your job
4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job for each

cost element
7.  Choose Cost Element: Resource
8.  Choose: Distributions
9.  Action: Verify the accounting distributions of your

job created by the transactions.

1.  Navigate to the WIP Value Summary window to
verify the value of your job.

(N) WIP Discrete > WIP Value Summary (B) Find > Value Summary
2.  Job: xx-job01
3.  Action: Verify the value of your job
4.  Choose Cost Element: Material
5.  Choose: Distributions
6.  Action: Verify the distributions of your job for each

cost element
7.  Choose Cost Element: Resource
8.  Choose: Distributions
9.  Action: Verify the accounting distributions of your

job created by the transactions.
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Guided Practice 2-3: Reviewing Job Costs
Using Discrete Job Value Report

Run the Discrete Job Value Report - Standard
Costing after you have closed your job.
1.  Navigate to the Request Value Reports window
(N) CST Report > Value
2. The Submit a new Request window opens
3. Check Select Single Request and choose OK
4. Name: Discrete Job Value Report - Standard
Costing
5. Choose: OK
(continued on next page)

Run the Discrete Job Value Report - Standard
Costing after you have closed your job.
1.  Navigate to the Request Value Reports window
(N) CST Report > Value
2. The Submit a new Request window opens
3. Check Select Single Request and choose OK
4. Name: Discrete Job Value Report - Standard
Costing
5. Choose: OK
(continued on next page)
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Guided Practice 2-3: Reviewing Job
Costs Using Discrete Job Value Report

6. Enter parameters:
7. Sort By: Job
8. Report Type: Summary
9. Class Type: Standard Discrete
10. Job From: Your job
11. Job To: Your job
12. Exchange Rate: 1
13. Select OK and choose submit
14. Record your request number here_________.

6. Enter parameters:
7. Sort By: Job
8. Report Type: Summary
9. Class Type: Standard Discrete
10. Job From: Your job
11. Job To: Your job
12. Exchange Rate: 1
13. Select OK and choose submit
14. Record your request number here_________.
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Guided Practice 2-3: Viewing the Results
Online

1. Navigate to the Requests window to check that
your report request has completed and to view output
online.
(N) CST Setup > Requests (B) View Output

2.  Check Specific Request
3.  Request ID: Enter your request number
4.  Choose: Find
5.  Choose: View Output

1. Navigate to the Requests window to check that
your report request has completed and to view output
online.
(N) CST Setup > Requests (B) View Output

2.  Check Specific Request
3.  Request ID: Enter your request number
4.  Choose: Find
5.  Choose: View Output
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Guided Practice 2-3: Reviewing Job
Costs Using the WIP Value Report

Run the WIP Value Report to identify your significant
variances with one line per job or repetitive assembly.
1.  Navigate to the Request Value Reports window
(N) CST Report > Value
2. The Submit a new Request window opens
3. Check Select Single Request and choose OK
4. Name: WIP Value Report
5. Choose: OK
(continued on next page)

Run the WIP Value Report to identify your significant
variances with one line per job or repetitive assembly.
1.  Navigate to the Request Value Reports window
(N) CST Report > Value
2. The Submit a new Request window opens
3. Check Select Single Request and choose OK
4. Name: WIP Value Report
5. Choose: OK
(continued on next page)
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Guided Practice 2-3: Reviewing Job
Costs Using the WIP Value Report

6. Enter parameters:
7. Report Type: Cumulative-to-Date
8. Period: Current period
9. Include Closed Jobs: Yes
10. Job/Schedules From: Your job number
11. To: Your job number
12. Exchange Rate: 1
13. Select OK and choose submit
14. Record your request number here_________.

6. Enter parameters:
7. Report Type: Cumulative-to-Date
8. Period: Current period
9. Include Closed Jobs: Yes
10. Job/Schedules From: Your job number
11. To: Your job number
12. Exchange Rate: 1
13. Select OK and choose submit
14. Record your request number here_________.
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Guided Practice 2-3: Viewing the Results
Online

1. Navigate to the Requests window to check that
your report request has completed and to view output
online.
(N) CST Setup > Requests (B) View Output

2.  Check Specific Request
3.  Request ID: Enter your request number
4.  Choose: Find
5.  Choose: View Output

1. Navigate to the Requests window to check that
your report request has completed and to view output
online.
(N) CST Setup > Requests (B) View Output

2.  Check Specific Request
3.  Request ID: Enter your request number
4.  Choose: Find
5.  Choose: View Output
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